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ABSTRACT 

 

 Glacial meltwater is a vital component of rivers and streams in glaciated regions 

such as the Pacific Northwest, and can be critical for municipal water supplies, power 

generation, and habitat issues. The Middle Fork of the Nooksack River is fed by meltwater 

from Deming Glacier on Mount Baker, WA.  The City of Bellingham has been diverting 

water from the Middle Fork since 1962 to supplement the water supply, and to maintain 

water quality in Lake Whatcom, the water source for the city.  Because of regulations, water 

is only diverted when the Middle Fork exceeds minimum acceptable streamflow. A concern 

for water resource managers in Whatcom County, WA, is that Deming Glacier is retreating.  

In this study, the Distributed Hydrology Soils Vegetation Model (DHSVM) is used to 

perform a detailed assessment of the hydrology in the Middle Fork basin, to quantify future 

meltwater contributions to the Middle Fork Nooksack River as Deming Glacier continues to 

retreat, and to evaluate streamflow contributions based on predicted climate change.   

  DHSVM is a physically based, spatially distributed hydrology model that simulates a 

water and energy balance at the pixel scale of a digital elevation model (DEM).  DHSVM 

requires multiple GIS input grids to characterize the watershed including a DEM, soil type, 

soil thickness, vegetation, stream network, and watershed boundary.  Required 

meteorological input includes an hourly time series of air temperature, relative humidity, 

incoming shortwave and longwave radiation, and wind speed.  Meteorological data were 

compiled from historical records of lower-altitude weather stations.   The model was 

calibrated to measured snow-water equivalent at the Middle Fork SNOTEL station and 

stream discharge at the USGS stream gauge on the Middle Fork using a 1-hour time step and 
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50 m GIS grid resolution.  Once calibrated, the model was applied to examine the effects of 

glacier size on streamflow.  The model was also applied to simulate future streamflow based 

on predicted future climate change scenarios. 

 The estimated glacial meltwater component of late-summer streamflow as defined by 

the 2002 glacier coverage and present climate conditions was between 8.4% and 26.1%, 

depending on the climate of a given year (wet year vs. dry year).  The late-summer glacial 

meltwater component was greater for drought simulations and predicted climate simulations, 

but less for increased precipitation simulations.  DHSVM consistently simulated a smaller 

glacial meltwater component for progressively smaller glaciers.  Simulation results suggest 

that late-summer streamflow in the Middle Fork could be reduced by as much as  8.6% as 

the direct result of glacier shrinkage predicted in the next fifty years, or by as much as 

15.7% as the result of glacier shrinkage and predicted climate change for the same time 

period.   

 Glacier shrinkage could have significant implications for salmon habitat and 

migration during the late-summer, and may in turn compromise the feasibility of the Middle 

Fork Nooksack diversion.  Further research is necessary to evaluate the effects of glacier 

shrinkage on the entire Nooksack watershed, particularly the North Fork. 

  

 



 vi

ACKNOWLEDGEMENTS 

 First and foremost, I would like to thank my thesis committee for all of the help and 

insight they provided me throughout the research process.  Bob Mitchell, Doug Clark, and 

Joanne Greenberg comprised a very well rounded committee.  I would also like to thank 

Katie Kelleher and Jay Chennault for always being willing to answer DHSVM questions.  

Mike Johnsen was an invaluable asset, as he helped me through many GIS problems.  Niki 

Bowerman helped with field work and lab analysis.  Finally, I would like to thank Kelsay 

Davis for housing me on my many trips back to Bellingham.  

 

 



 

 vii

TABLE OF CONTENTS 
 
ABSTRACT .............................................................................................................................. iv 
ACKNOWLEDGEMENTS ................................................................................................vi 
TABLE OF CONTENTS .................................................................................................. vii 
LIST OF TABLES ...............................................................................................................ix 
LIST OF FIGURES ..............................................................................................................x 
1.0 INTRODUCTION ..........................................................................................................1 
2.0 BACKGROUND .............................................................................................................3 

2.1 Middle Fork Nooksack Watershed ...................................................................3 
2.1.1 Middle Fork Nooksack River ................................................................3 
2.1.2 Geologic setting .....................................................................................4 
2.1.3 Glaciers ..................................................................................................4 
2.1.4 Soils ......................................................................................................6 
2.1.5 Vegetation..............................................................................................7 
2.1.6 Climate...................................................................................................7 

2.2 Previous work......................................................................................................8 
2.2.1 Mass balance studies..............................................................................8 
2.2.2 Runoff studies......................................................................................11 
2.2.3 DHSVM studies...................................................................................13 

3.0 RESEARCH OBJECTIVES........................................................................................14 
4.0 METHODS ....................................................................................................................14 

4.1 Basin setup.........................................................................................................15 
                        4.1.1 DEM ....................................................................................................15 
                        4.1.2 Watershed boundary ............................................................................15 
                        4.1.3 Landcover ...........................................................................................16 

4.1.4 Soil classifications ...............................................................................16 
4.1.5 Soil thickness .......................................................................................16 
4.1.6 Stream network....................................................................................17 

4.2 Meteorological data ..........................................................................................17 
4.3 Streamflow and diversion data........................................................................19 
4.4 Calibration and validation ...............................................................................20 

4.4.1 Calibration ...........................................................................................20 
4.4.2 Validation ............................................................................................23 

4.5 Simulating glacial melt .....................................................................................23 
4.6 Glacial melt experiments..................................................................................26 

4.6.1 Present climate and different glacier coverages ..................................27 
            4.6.2 Drought and increased precipitation scenarios ....................................30 
            4.6.3 Predicted climate change for the Pacific Northwest............................30 

5.0 RESULTS AND DISCUSSION ...................................................................................31 
5.1 Basin setup.........................................................................................................32 
5.2 Meteorological data ..........................................................................................32  
5.3 Calibration and validation ...............................................................................33 

5.3.1 Calibration ...........................................................................................33 
                        5.3.2 Validation and potential errors ............................................................36 



 viii

5.4 Glacial melt experiments..................................................................................40 
5.4.1 Present climate and different glacier coverages ..................................40 
5.4.2 Drought scenario and 2002 glacier coverage.......................................45 
5.4.3 Increased precipitation scenario and 2002 glacier coverage ...............48 
5.4.4 Predicted climate scenario with 2002 and predicted 2050  
         glacier coverages .................................................................................50 
5.4.5 Summary of glacial melt experiments .................................................52 

5.5 Implications .......................................................................................................54 
6.0 CONCLUSIONS ...........................................................................................................54 
7.0 FUTURE WORK..........................................................................................................57 
8.0 REFERENCES .............................................................................................................58 
APPENDIX A: DHSVM basin setup ................................................................................. 89 
APPENDIX B: Table of all calibration and validation simulations performed ..................99 
APPENDIX C: Contents of disc .......................................................................................103 
 



 

 ix

 
LIST OF TABLES 

 
Table 1:  Monthly precipitation sums and average air temperature for meteorological  
 input files (SNOTEL and synthetic) and Clearbrook weather station................62 
Table 2:  Vegetation hydrologic parameters........................................................................63 
Table 3:  Soil hydrologic parameters...................................................................................63 
Table 4:  Location of SNOTEL, weather, and stream gauging stations ..............................64 
Table 5:  Glacier coverage in the Middle Fork Basin for discrete time periods..................64 
Table 6:  Measured and simulated snow-water equivalent at the Middle Fork SNOTEL 
 station .................................................................................................................65 
Table 7: Contribution of glacial meltwater to streamflow in the Middle Fork Nooksack 
    River using present meteorological conditions (WY 2003-2005) and different  
 glacier sizes.........................................................................................................66 
Table 8: Change in glacier melt using present meteorological conditions and different 
 glacier sizes.........................................................................................................67 
Table 9: Change in total stream discharge using present meteorological conditions and 
 different glacier sizes..........................................................................................68 
Table 10: Glacial meltwater component of streamflow for drought scenario and 2002  
 glacier coverage ..................................................................................................69 
Table 11: Change in glacier melt compared to present meteorological and glacier  
 conditions............................................................................................................69 
Table 12: Change in total stream discharge for drought scenario and 2002 glacier 
 coverage..............................................................................................................69 
Table 13: Glacial meltwater component of streamflow for increased precipitation  
 scenario and 2002 glacier coverage....................................................................70 
Table 14: Change in glacier melt compared to present meteorological and glacier  
 conditions............................................................................................................70 
Table 15: Change in total stream discharge for increased precipitation scenario with  
 2002 glacier coverage .........................................................................................70 
Table 16: Glacial meltwater component of streamflow for predicted climate scenario  
 with 2002 and predicted 2050 glacier coverage .................................................71 
Table 17: Glacier discharge for predicted climate scenario with 2002 and predicted 
 2050 glacier sizes................................................................................................71 
Table 18: Change in total stream discharge for predicted climate scenario with 2002  
 and predicted 2050 glacier sizes .........................................................................72 
 
Table B1: Table of all calibration simulations performed using three meteorological  
 stations ................................................................................................................99 
Table B2: Table of all calibration simulations performed using Elbow Lake  
 Meteorological station ........................................................................................99 
Table B3: Table of all calibration simulations performed using Middle Fork 
 meteorological station.......................................................................................100 
 



 x

LIST OF FIGURES 
 
Figure 1:  Location of Middle Fork Nooksack watershed and associated stream gauges  
                  and SNOTEL sites ................................................................................................73 
Figure 2:  Conceptual model of DHSVM..............................................................................74  
Figure 3:  DEM of Middle Fork Nooksack watershed ..........................................................74 
Figure 4:  2002 vegetation grid of Middle Fork Nooksack watershed..................................75 
Figure 5:  Soil classifications in the Middle Fork Nooksack watershed ...............................75 
Figure 6:  Soil thickness in Middle Fork Nooksack watershed.............................................76 
Figure 7:  Stream network in Middle Fork Nooksack watershed..........................................76 
Figure 8:  17% glacier size reduction (predicted for year 2050) ...........................................77 
Figure 9:  48% glacier size reduction (predicted for year 2150) ...........................................77 
Figure 10:  0% Glacier coverage ...........................................................................................78 
Figure 11:  144% glacier size increase (estimated for LIA)..................................................78 
Figure 12:  Location and ages of wood samples for radiocarbon dating...............................79 
Figure 13:  First calibration simulation with default parameters...........................................80 
Figure 14:  Mean monthly stream discharge with different soil thickness............................80 
Figure 15:  Mean monthly stream discharge with different precipitation lapse rates............81 
Figure 16:  Mean monthly stream discharge with different temperature lapse rates ............81 
Figure 17:  Stream hydrograph before calibrating to snow-water equivalent .......................82 
Figure 18:  Simulated and measured snow-water equivalent at Middle Fork  
                    SNOTEL site ......................................................................................................82 
Figure 19:  Stream hydrograph for calibrated model WY 2005............................................83 
Figure 20:  Stream hydrograph for validated model for WY 2003 .......................................83 
Figure 21:  Stream hydrograph for validated model for WY 2004 .......................................84 
Figure 22:  Total stream discharge for calibration and validation periods............................84 
Figure 23:  Glacial meltwater contribution for WY 2003 and 2002 glacier coverage ..........85 
Figure 24:  Glacial meltwater contribution for WY 2003 and 2050 glacier coverage ..........85 
Figure 25:  Glacial meltwater contribution for WY 2003 and 2150 glacier coverage ..........86 
Figure 26:  Glacial meltwater contribution for WY 2003 and LIA glacier coverage ...........86 
Figure 27:  Stream discharge for WY 2003 and all glacier sizes ..........................................87 
Figure 28:  Snow-water equivalent for water years 2003-2005 at Middle Fork SNOTEL ...87 
Figure 29:  Summary of melt experiments ............................................................................88 
 
 
 
 
 
 
 
 
 



1.0 INTRODUCTION 

Glaciers in Washington’s North Cascades are a vital hydrologic resource because 

they store a significant volume of frozen water and they tend to moderate discharge in 

glacier-fed streams.  Specifically, glaciers store excess precipitation during wet winters, 

whereas increased melting during warm, dry periods produces more runoff, thus damping 

the seasonal fluctuations of runoff in a stream (Fountain and Tangborn, 1985).    In the same 

manner, glaciers buffer the effects of regional droughts.  The volume of runoff from a 

glacier is primarily a function of glacier area.  Consequently, smaller glaciers do not produce 

as much runoff as larger glaciers (Rango et al., 1979). Understanding regional glaciers is 

therefore essential for water resources management. 

A concern for water resource managers in Whatcom County, Washington, is that 

Deming Glacier has been retreating during the past century.  The Middle Fork of the 

Nooksack River is fed by meltwater from Deming Glacier on Mount Baker (Figure 1).  The 

City of Bellingham has been diverting water from the Middle Fork since 1962 in order to 

supplement the supply of water to Lake Whatcom, the water source for the city (Walker, 

1995; Figure 1).  Also, the flushing effect of the diverted water may help maintain the 

overall water quality in Lake Whatcom (Walker, 1995).  The diverted water may account for 

up to 80% of the surface inflow into Lake Whatcom during the summer and 20% of the 

city’s yearly water consumption (Tracy, 2001).  As Bellingham continues to grow, so will its 

water needs.   

By law, the city must maintain the legal water level of Lake Whatcom below   

314.94 ft above mean sea level (AMSL) and is allowed no more than a four foot fluctuation 

below that level (Ecology, 1985).  The Instream Resources Protection Program (IRPP) 
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stipulates that water can only be diverted to Lake Whatcom when flow in the Middle Fork 

exceeds 275 cubic feet per second (cfs) in most months, the minimum necessary streamflow 

for salmon migration (Ecology, 1985). Diversion cannot occur in June and half of July 

unless streamflow exceeds 525 cfs (J. Greenberg, personal communication).   As the surface 

area of Deming Glacier decreases, summer streamflow will likely decrease in the Middle 

Fork (Pelto, 2003). Therefore, a quantitative assessment of the influence of Deming glacier 

on streamflow in the Middle Fork is necessary for future water resource planning in 

Whatcom County, WA.  I performed this assessment using hydrologic simulation modeling. 

Hydrologic simulation modeling began in the 1950s and 1960s with the introduction 

of the digital computer. The primary focus of modeling at the time was streamflow 

forecasting, design and planning for flood protection, and extension of streamflow records 

(Storck et al., 1998).  Early models were spatially “lumped,” meaning that heterogeneities of 

a basin were not modeled explicitly, but the effective response of an entire watershed was 

characterized.  Although spatially lumped models are still in wide use today, they do not 

represent the spatial variability of hydrological processes and watershed parameters (Storck 

et al., 1998).  The development of spatially distributed models in the last ten years has been 

made possible by the availability of detailed land surface data as well as the rapid increase in 

desktop computing power.  Distributed models have many important applications for the 

interpretation and prediction of potential effects of land use change on watershed 

characteristics (Storck et al., 1998).    

The Distributed Hydrology Soils Vegetation Model (DHSVM) was developed at the 

University of Washington and Pacific Northwest National Laboratory and is one of the most 

sophisticated hydrologic models available (Wigmosta et al., 1994).  The model simulates a 
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water and energy balance at the pixel scale of a digital elevation model (DEM; Figure 2).  It 

has been applied predominantly to mountainous watersheds in the Pacific Northwest to 

simulate hydrologic responses to weather and land use conditions (e.g., Bowling and 

Lettenmaier, 2001; Chennault, 2004; Storck et al., 1995, 1998; Wigmosta and Perkins, 

2001).  Required input for DHSVM includes a DEM, watershed boundary, soil 

classifications, soil depth, vegetation classifications, stream flow data, and meteorological 

data.   

I applied DHSVM to quantify present and future meltwater contributions to the 

Middle Fork Nooksack River as Deming Glacier continues to retreat at the historic rate, and 

under a variety of climatic conditions.   This assessment provides a quantitative evaluation 

of the relationship between glacier size and runoff, which will aid researchers in evaluating 

the responses of other alpine stream systems to changes in glacier size.  

 

2.0 BACKGROUND 

 In order to model streamflow in the Nooksack drainage basin, classification of the 

local topography, geology, glaciers, soils, vegetation, and climate is essential, as these 

parameters are required input for DHSVM. 

 

2.1 Middle Fork Nooksack watershed 

2.1.1 Middle Fork Nooksack River 

The main stem of the Nooksack River occupies a valley of thick alluvium with an 

approximate average gradient of 12 m/km for most of its length. The Nooksack has three 
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main tributaries including the North, Middle, and South Forks which all converge near 

Deming, WA (Figure 1).  The Middle Fork is the focus of this study.   

The gradient of the Middle Fork is variable, ranging from 71 m/km upstream to      

13 m/km near its confluence with the North Fork.  The headwaters of the Middle Fork 

originate at Deming Glacier (Figure 1).  The area of the Middle Fork watershed is 

approximately   260 km2.   

 

2.1.2 Geologic setting 

The Middle Fork basin is located on the southwest flank of Mt. Baker, WA.  Mt. 

Baker is an active volcano located approximately 53 km east of Bellingham, WA and 24 km 

south of the Canadian Border in the Cascade Range.  It is the highest peak in the north 

Cascades and is one of a cluster of volcanoes that make up a Quaternary volcanic field.  The 

modern dome which is less than 30,000 years old overlies the remnants of Black Buttes 

volcano, an older volcanic dome that was active approximately 300,000 to 500,00 years ago 

(Gardner et al., 1995).   

 

2.1.3 Glaciers 

Mt. Baker is the second most heavily glaciated volcano in the Cascades (second only 

to Mt. Rainier) and is largely covered by 1.8 km3 of snow and ice 1800 m AMSL (Gardner 

et al., 1995). During the late Pleistocene, thick ice related to the advance of the Cordilleran 

ice sheet filled valleys and covered the region up to ~1300 m AMSL (Gardner et al., 1995).  

Although much of the ice in the surrounding area melted at the close of the Pleistocene, Mt. 

Baker remains heavily glaciated.  Ten major glaciers terminate between 1200 m and 1800 m 
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AMSL on Mt. Baker (Harper, 1992).  The glaciers are drained radially by tributaries of the 

Nooksack River and the Baker river branch of the Skagit River.  

 Deming Glacier is a southwest oriented temperate valley glacier that dominates the 

headwaters of the Middle Fork basin.  The source of accumulation for Deming Glacier is 

direct snowfall with minor drift snow (Post et al., 1971).  As of 1980, the glacier measured 

approximately 4.8 km in length and 4.5 km2 in area (Fuller, 1980).  These measurements 

overestimate present glacier size, however, because the glacier has retreated since 1980.  

The width of Deming Glacier is variable; it has a wide accumulation zone and a narrow 

terminal tongue.  The head elevation of Deming Glacier is 3260 m AMSL and the terminus 

is confined by steep valley walls at approximately 1340 m AMSL.  The majority of the 

glacier’s mass is located between 2,000 m and 2,500 m AMSL. The average surface slope of 

Deming Glacier is 19.6° (Post et al., 1971). Deming glacier is heavily crevassed, has an ice 

fall between 1645 m and 1825 m, and terminates on a moderate to low slope. As a result of 

the low surface slope near its terminus and relatively large area, Deming Glacier is likely the 

thickest glacier on Mt. Baker (Harper, 1992).   

 Although Deming Glacier is the dominant glacier in the Middle Fork basin, it is 

important to note that it is not the only glacier in the basin.  Portions of the Twin Sisters 

Glaciers and Thunder Glacier also feed into the basin.  Although the modern meltwater 

contribution to the Middle Fork from the latter glaciers may be small, it is nonetheless 

present, and likely had more influence on streamflow in the past when those glaciers were 

larger. 

After retreating significantly early in the 20th Century, Deming Glacier advanced 

beginning in the 1950s, then began retreating again in 1987.  Between 1987 and 2002, the 
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glacier retreated approximately 360 m (Pelto, 2003).  Retreat will likely continue into the 

foreseeable future.  However, because the glacier is so thick, it will probably continue to 

retreat at a slow, steady pace (Pelto, 2003). 

   Historic glacier inventories help to characterize the recent behavior of Deming 

Glacier. The first comprehensive glacier inventory in the North Cascades that includes Mt. 

Baker glaciers was completed by Post et al. (1971).  The inventory was based on aerial 

photos that were taken in the 1950s. The report includes 756 glaciers having a combined 

area of 267 km2.  Post et al. (1971) also included analyses of the hydrologic significance and 

spatial characteristics of the glaciers.    

A more recent glacier inventory has been completed in the North Cascades National 

Park Complex by Frank Granshaw (2002) of Portland State University.  Granshaw’s 

inventory was based on aerial photos from 1998.  He digitized his inventory of 1998 glaciers 

as well as Post’s (1971) 1950s glaciers into a Geographical Information System (GIS).  The 

more recent inventory does not include Deming Glacier because it is not included in North 

Cascades National Park, but it is useful nonetheless for examining regional glacier behavior 

between the 1950s and 1998.  Granshaw (2002) noted an average of 7% area loss throughout 

the complex since 1958.   

  

2.1.4 Soils 

Two dominant types of soil occur in the Middle Fork basin (Goldin, 1992).  The first 

is loam that was formed in either a mixture of volcanic ash and loess over glacial outwash or 

colluvium derived from glacial till.  The colluvium is derived dominantly from dunite.  The 
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second soil type is riverwash that is formed on land that is frequently flooded.  Minor 

gravelly loam also occurs in the area (Goldin, 1992).   

 

2.1.5 Vegetation 

 Three broad regions of vegetation occur within the North Cascades including a 

Tsuga Heterophylla (Western Hemlock) zone, subalpine zone, and timberline or alpine zone 

(Goldin, 1992; Franklin and Dyrness, 1973).  The first zone consists mainly of Western 

Hemlock, Douglas Fir, and Western Red Cedar.  The subalpine forest consists mainly of 

Cascades Fir, Alpine Fir and Mountain Hemlock.  Other vegetation in the area includes 

salal, red huckleberry and Western sword fern.  The alpine zone is heavily glaciated or has 

been recently deglaciated and is being revegetated. 

 

2.1.6 Climate 

 Climate in the area of the Middle Fork can be highly variable, but is typified by 

warm, dry summers and cool, wet winters (see the 75-year monthly average temperature and 

precipitation for the Clearbrook weather station in Table 1; Figure 1).  Regional climate is 

controlled by the interaction between meteorological conditions produced by atmospheric 

pressure patterns and local topography.  Maximum precipitation occurs in the winter and 

minimum precipitation occurs during mid-summer (Fountain and Tangborn, 1985).  

Precipitation generally increases with elevation while temperature generally decreases with 

elevation in the study region.   

Peaks reaching 1500 m to 2000 m AMSL on the Olympic Peninsula and Vancouver 

Island tend to reduce the precipitation of storms moving into the North Cascades. The 
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Straight of Juan De Fuca and the Straight of Georgia, on the other hand, act to funnel 

westerly storms into the region (Harper, 1992). The Cascade Mountains orographically 

block weather related to the Washington interior, thus isolating western Washington from 

the warmer summer temperatures and colder winter temperatures found east of the crest.   

 

2.2 Previous work 

Hydrologic modeling is one of a variety of methods that can be used to estimate 

glacier meltwater input to streams.  Mass balance measurements, meteorological data and 

streamflow analyses have also been used to estimate glacial meltwater.   

 

2.2.1 Mass balance studies  

 Mass balance measurements have been used regionally to estimate glacier meltwater 

contributions to mountain streams in the North Cascades as well as to determine the rate at 

which North Cascades glaciers are receding.  Glaciers are sensitive indicators of climate 

change; they continually preserve a record of meteorological information in remote locations 

spanning great periods of time.  Glacier annual mass balance is the most sensitive indicator 

of a glacier’s response to changes in climate.  The mass balance of glaciers in any mountain 

range varies due to local meteorological complexities and variation in aspect and 

hypsometry.  It is therefore necessary to study a large number of glaciers in a mountain 

range to understand the overall trend in mass balance of glaciers in the region (Pelto, 1996).  

No detailed mass balance measurements have been made on Deming Glacier.  However, 

several glacier mass balance studies have been conducted across the region during the past 

two decades (Pelto, 1996; Reidel et al, 1999).   
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In 1997 the USGS proposed a three-tiered program to improve glacier monitoring in 

the northwest in a cost-effective way. Mass balance studies can be very expensive, and the 

cost of a regional monitoring program is greatly reduced by intensively monitoring only a 

few glaciers and using the data to estimate regional glacier change.  Tier-1 glacier 

monitoring includes detailed surface measurements of mass balance, meteorological data 

and water runoff whereas tier-2 glacier monitoring is limited to measures of annual mass 

balance using a two-season mass balance measuring approach (Fountain et al, 1997). Tier-3 

glacier monitoring utilizes remote sensing techniques to define changes in snow and/or ice 

areal extent. USGS estimates have also been compared to less detailed glacier mass balance 

measurements for the entire region (Pelto and Riedel, 2001).  

 The most intensively monitored glacier in the region is South Cascades Glacier (a 

tier-1 glacier).  The USGS has been monitoring South Cascade Glacier annually since 1958.  

It was selected for detailed study based on its similarity to other glaciers in the region, ease 

of access, and extent of previous mass balance measurements.  It has been noted by 

researchers for the North Cascades National Park, however, that the South Cascade Glacier 

is not representative of all glaciers in the Park, particularly those on the east-slope (Riedel et 

al., 1999). Tangborn et al. (1975) conducted a study comparing mass balance measurements 

of South Cascade Glacier using mapping, glaciological, and hydrological methods.  The 

mapping and glaciological methods of estimating mass balance showed close comparison 

with each other (within 5%) and are considered reliable methods.  The mass balance that 

was estimated using the hydrological method was 38% higher than that estimated using 

mapping or glaciological methods.  The difference is most likely due to the release of stored 

liquid water in the summer (Tangborn et al., 1975). 
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Geologists from the North Cascades National Park have been monitoring four tier-2 

glaciers in the North Cascades since 1993 (Riedel et al, 1999).  Noisy Creek, Silver, North 

Klawatti, and Sandalee Glaciers were chosen for study because of their geography, aspect, 

elevation, shape, and safety and ease of access.  The main goals of the study are to monitor 

annual variation of the four glaciers, to examine variation at several time scales, to 

determine how well glaciers in the region are represented by South Cascade Glacier, and to 

aid in development of a system to monitor all glaciers in the North Cascades National Park 

(Riedel et al, 1999).   

 Additional mass balance monitoring is conducted as part of the North Cascades 

Glacier Climate Project (NCGCP), which was founded by Mauri Pelto in 1984 with the 

purpose of examining the response of glaciers to climate change (Pelto, 2001).  The NCGCP 

has monitored the annual mass balance of at least eight glaciers since it was founded.  

Accumulation is measured using snow stratigraphy and probing methods in early summer, 

late July, and at the end of September.  Ablation is measured in July and August of each 

year using a minimum of six stakes on each glacier.  Although an extensive mass balance 

study of Deming Glacier has not been conducted, the NCGCP has been monitoring annual 

mass balance of Easton and Rainbow Glaciers on Mt. Baker since 1990 and 1984, 

respectively.  Although variability among mass balances of glaciers in the North Cascades 

exists, cross correlation has shown that all of the glaciers have exhibited similar first-order 

responses to changes in climate since 1984 (Pelto,1996).  

Annual glacier mass balance has also been empirically modeled for glaciers in the 

North Cascades using observations of precipitation, temperature, and run-off at low 

elevation weather stations (Tangborn, 1980).  Tangborn concluded that these meteorological 
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records can be used to estimate accumulation, ablation, and mass balance of glaciers in the 

North Cascades. 

 

2.2.2 Runoff studies  

Approximately 75% of the total volume of global fresh water is stored in the form of 

glacial ice (Meier, 1984).  North Cascade glaciers alone supply approximately 8.0x108 m3 of 

runoff each summer, or approximately 25-30% of the region’s total summer water supply 

(Pelto, 1991).  Estimates that glacier area in the North Cascades will decline by up to 25% in 

the next 20 years indicate that continued warming may lead to a decrease in glacial 

meltwater of 35% (Pelto, 1991).  The importance of glacier runoff is increasing as water 

uses and needs in Washington State become fully realized.  Present issues include 

competition for in-stream and out-of-stream water allocation.  Therefore, monitoring of the 

regions glaciers and glacier runoff is important for water resources management.   Numerous 

glacier runoff studies have been conducted in the North Cascades.  However, most of the 

studies are qualitative and fail to consider many of the important hydrologic attributes of a 

basin.  Following is a discussion of several glacier runoff studies that have led to the 

development of the comprehensive hydrologic model that I used to quantify the glacier 

meltwater contribution to the Middle Fork Nooksack River. 

Researchers have compared streamflow in two basins having similar precipitation 

characteristics and hydrologic attributes, with the exception that one basin is glaciated and 

the other is non-glaciated (e.g. Meier 1986; Fountain and Tangborn, 1985; Pelto, 1991; 

Krimmel, 1992).  The major assumption made in this type of study is that the difference in 

runoff between the two basins can be attributed to glacial meltwater (Krimmel, 1992).  
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Glacierized and non-glacierized basins that were studied in the North Cascades were chosen 

based on area, altitude, and location.  The results of the studies indicate that glaciers play a 

crucial role in the timing, volume, and quality of runoff in a basin.  For example, streamflow 

in a basin with 20% glacier cover can be as much as 50% greater than in a non-glaciated 

basin during the summer period (Fountain and Tangborn, 1985).  Although the studies 

produce runoff results that are considered satisfactory, they fail to account for a number of 

fundamental physical attributes of a basin as well as any heterogeneities between basins.  

Researchers have also modeled streamflow in a basin based on estimates of 

snow/glacier melt (e.g. Rango et al., 1979; Martinec and Rango, 1986; Rango, 1988; and 

Arnold et al., 1996).  Rango et al. (1979) attempted to improve streamflow forecasting in 

two California basins by examining the effect of snow covered area on runoff volume.  

Martinec and Rango (1986) developed the ‘Snowmelt Runoff Model’ which they considered 

to produce ‘acceptable’ streamflow results.  Arnold et al. (1996) developed a 3-D distributed 

model that calculates spatial and temporal variations in energy-balance components and, 

therefore, the melting of small valley glaciers.  The modeling results supported the previous 

concept that the most influential factor in melt-energy of a glacier is solar radiation, 

specifically short-wave radiation.  All of these studies produced reasonable results but failed 

to account for many important hydrologic attributes of the basins such as soils, vegetation, 

and topography. 

 A study conducted by Pelto (2003) of the glacial meltwater contribution of Deming 

Glacier to the Middle Fork Nooksack River was based on mass balance measurements of 

Easton Glacier, precipitation records, and Middle Fork discharge measurements. Results of 

the study indicate that glacial meltwater can contribute up to 30% of the streamflow in the 
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Middle Fork during a dry summer season.  Bach (2002) examined the snowmelt contribution 

to streamflow in the Nooksack River above the town of Deming, WA, and found that the 

snowmelt contribution to the watershed increased from about 25% to approximately 31% 

between the 1940s and 1990s. Overall stream discharge, however, did not significantly 

increase during this time. This suggests that precipitation levels and other hydrologic factors 

are decreasing at the same rate that the snow and glacier melt is increasing (Bach, 2002).  As 

with the others, these studies did not account for many hydrologic attributes of the basin.   

 Chennault (2004) examined the effect of glacier areal extent on streamflow in the 

Thunder Creek basin, North Cascades National Park, Washington. He performed his study 

using DHSVM, which accounts for the important hydrologic attributes of the basin 

including soil and vegetation hydrologic parameters.  Chennault examined the influence of 

glacier size on streamflow by altering the size of glaciers in the basin and performing 

numerous model simulations.  Major conclusions of the study are as follows.  Glacial 

meltwater contribution to streamflow is highly dependent on the amount of precipitation 

during a given year, and varied from 0.6% to 56.6% contribution during late-summer for the 

Thunder Creek basin.  Warm and dry years typically correspond to the largest percentage of 

glacial meltwater in the stream, while the influence of the glaciers is dampened during cool 

and wet years (Chennault, 2004). 

 

2.2.3 DHSVM studies 

 DHSVM was first validated for the Middle Fork Flathead River, MT (Wigmosta et 

al., 1994).  The original purpose of the model was to reproduce seasonal stream hydrographs 

and to examine the effects of snow areal extent on streamflow during spring snowmelt.  The 
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model has since been used to simulate rain-on-snow events (Storck et al., 1995), to examine 

effects of changing land use patterns on streamflow (e.g., Bowling and Lettenmaier, 2001; 

Storck et al., 1998; Wigmosta and Perkins, 2001; Kelleher, 2006), and to evaluate the effects 

of glacier area on stream flow in glacierized basins (Chennault, 2004). 

 

3.0 RESEARCH OBJECTIVES 

The objective of my research was to use DHSVM to evaluate the effects of glacial 

retreat and predicted climate change on the streamflow in the Middle Fork Nooksack River, 

Whatcom County, Washington. I calibrated the model to both measured snow-water 

equivalent (SWE) at the Middle Fork SNOTEL station and stream discharge at the USGS 

stream gauge on the Middle Fork (Figure 1). I applied the model to examine the glacial 

meltwater component of streamflow in the Middle Fork using several different glacier ice 

extents including Little Ice Age (LIA) maximum, present size, and “future conditions” in 

which the Deming Glacier has significantly shrunk.  I also applied the model to examine the 

influence of various climate scenarios on the glacial meltwater contribution to streamflow. 

  

4.0 METHODS 

Following is a discussion of the methods used to complete data collection, model 

calibration and validation, and analysis.  Meteorological data collection and GIS input grid 

generation were completed during fall, 2005.  Data were formatted and input to the program 

during winter 2005-06.  Model calibration and validation took place during summer and fall 

2006.  Glacial melt experiments and analysis took place during fall, 2006.  
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4.1 Basin setup 

 DHSVM requires five GIS input grids including a DEM, landcover, soil type, soil 

thickness, and stream network.  All grids were clipped to the watershed boundary.  

Meteorological data are also a DHSVM input requirement.  Meteorological data were 

collected from lower elevation climate stations (Figure 1).  Historical streamflow records 

were used for calibration and validation of the model, and were collected from a gauge on 

the Middle Fork that is maintained by the USGS.  Following is a brief description of the GIS 

input grids used by DHSVM.  A detailed explanation of GIS methods is found in Appendix 

A.   

 

4.1.1 DEM 

 The DEM characterizes the topography of a watershed and is the foundation on 

which the distributive parameters of DHSVM such as temperature, precipitation, and water 

flow direction are based (Storck et al., 1995).  The DEM for my study area was compiled 

from eight 7.5 minute, 10 m DEM files including Deming, Canyon Lake, Goat Mountain, 

Mt. Baker, Acme, Cavanaugh Creek, Twin Sisters, and Baker Pass.  I ‘merged’ the DEMs 

and resampled them to 50 m by 50 m grid resolution using ArcGIS9 (Appendix A).  The 

DEM was then clipped to the watershed boundary (Figure 3). 

 

4.1.2 Watershed boundary 

  The watershed boundary was derived from the DEM using the interactive ‘hydrology 

modeling’ tool in ArcGIS9 (Appendix A). The watershed grid includes all pixels that 

eventually drain into the Middle Fork and is used as a template for all GIS grids (Storck et 
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al., 1995). All GIS grids were clipped to the watershed boundary to ensure that all grids have 

the identical number of overlapping cells. 

 

4.1.3 Landcover  

The landcover grid was generated from a 2002 landcover grid file from the National 

Oceanic and Atmospheric Administration (NOAA; http://www.csc.noaa.gov/crs/lca/pacific 

coast.html). I resampled the vegetation grid to 50 m by 50 m resolution and reclassified 

vegetation classes to the classification scheme used by DHSVM (Figure 4, Appendix A).  

DHSVM only uses the dominant overstory species in each pixel and each vegetation 

classification is assigned vegetation-dependent hydraulic parameters with the use of a look-

up table (Storck et al., 1995; Table 2).  Glaciers are part of the vegetation grid. 

 

4.1.4 Soil classifications 

 The soil type grid was generated using the 2002 soil data set from the State Soil 

Geographic Database (STATSGO; Miller and White, 1998; Appendix A, Figure 5).  

DHSVM only uses the primary soil type/texture in a given cell, and all cells with the same 

soil type are assigned one set of soil-dependent hydraulic parameters from a lookup table 

that was indexed by class specifically for DHSVM (Storck et al., 1995, Table 3).   

 

4.1.5 Soil thickness 

 Soil thickness data do not exist for the study area. To model soil thickness, I used an 

Arc Macro Language (AML) script that was written at the University of Washington to 

automate a number of GIS commands (Appendix A; Figure 6). The soil thickness AML uses 
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a simple regression that calculates deep soil depths on shallow slopes and areas of high flow 

accumulation given a minimum and maximum soil thickness (Chennault, 2004).  This type 

of AML has been used before with DHSVM and has provided acceptable results.  

 

4.1.6 Stream network 

 The stream network grid was created using an AML script that creates the stream 

network as a series of distinct but connected reaches, based on stream order (Appendix A; 

Figure 7). Each reach is assigned attributes such as channel width, depth, and roughness 

(Storck et al., 1998).  Flow networks created with this method have provided acceptable 

results in similar basins.   

 

4.2 Meteorological data 

DHSVM models two-story interception and evapotranspiration, soil evaporation, 

infiltration, subsurface flow and runoff in a basin using a meteorological input file that 

includes hourly maximum temperature, precipitation, long and short wave radiation, wind 

speed, and relative humidity (Storck et al., 1995).  All modeling is based on established 

hydrologic relationships (e.g., Darcy’s law and the Penman-Monteith equation).  

Temperature is distributed over the basin vertically using either a constant lapse rate or a 

variable lapse rate that can be changed between any time-step.  Precipitation can be 

distributed by a constant elevation lapse rate or by using a precipitation model.  Incoming 

solar radiation is distributed using a series of shading maps derived from the DEM 

(Appendix A).   
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I compiled three meteorological data files using a combination of lower elevation 

SNOTEL sites including Elbow Lake, Wells Creek, and Middle Fork, and the North Shore 

weather station in the Lake Whatcom watershed, western Whatcom County, WA (Figure 1, 

Table 4).    DHSVM interpolates meteorological data between observation stations (Storck 

et al., 1998).   

 I acquired hourly observed temperature, precipitation, and wind speed data from 

each SNOTEL site.  I imported data for water years (WY) 2003-2005.  A water year begins 

on October 1st of one year and ends on September 30th of the subsequent year (e.g., WY 

2005 begins on October 1, 2004 and ends September 30, 2005).  I imported all data into an 

Excel spreadsheet for formatting.  The first step in formatting was to evaluate the occurrence 

of missing data during the five year period.  A complete data set would have 8761 hours per 

year, (8762 for leap year 2004).  I then inserted blank cells as place holders for missing data.  

Precipitation data were recorded as accumulated precipitation.  Many of the hourly values 

required manipulation, as data obtained from SNOTEL sites were only verified at hour 0:00 

each day.  Because data were given as accumulation, precipitation values necessarily ascend 

chronologically from zero precipitation (Oct 1) to total precipitation (Sep 30) for a given 

year.  I ensured that all data ascended from the value at time 0:00 one day to the value at 

time 0:00 the next day.  DHSVM requires hourly data, so I simply calculated the difference 

between accumulated precipitation at any hour (t0) from the accumulated precipitation the 

following hour (t1).   

 Temperature data were reported as ‘observed temperature’ each hour.  Cells with 

missing values were given a value of 9999.99.  I plotted temperature for each data set and 

evaluated the occurrence of missing data.  I calculated any missing temperature 
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measurements as the mean of the temperature in the two time-adjacent cells.  Missing data 

was rarely more than a few hours at a time.  Monthly average temperatures for the input files 

are summarized in Table 1. 

 Wind speed values were handled similar to temperature data.  Wind speed values 

were plotted for each data set. Missing values were located and calculated as the mean of the 

values in the two time-adjacent cells.  Because wind speed magnitudes at Wells Creek and 

Elbow Lake were suspiciously low, I opted to use data from the North Shore weather station 

in western Whatcom County because of its completeness and availability (Figure 1). 

 Solar radiation and relative humidity were not available at SNOTEL stations used in 

this study.  Instead, I collected these data from the North Shore weather station in western 

Whatcom County (Figure 1).  Longwave radiation is not collected. Dr. Robert Mitchell 

modeled hourly longwave radiation using measured shortwave radiation and weather data 

from the North Shore weather station. These data were then used for model calibration.   

 

4.3 Streamflow and diversion data 

Measured streamflow data were used for model calibration and validation.   Data 

were obtained from a gauging station on the Middle Fork that has been maintained by the 

USGS since 1992.  However, the USGS station is located downstream of the Middle Fork 

diversion (Figure 1), so I adjusted the USGS data using diversion records acquired from the 

City of Bellingham.  Diversion data were most important during the summer months.  At the 

time of model calibration, diversion data were only available to me for WY 2005 (Oct. 1, 

2004 – Sep. 30, 2005), which then became the calibration period.   Diversion records were 

kept every five minutes.  I converted all data to a one-hour time-step by averaging the five 
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minute data for each hour.  Diversion data were necessary to reconstruct natural flow in the 

Middle Fork; otherwise DHSVM would overestimate streamflow at the USGS gauging 

station during times when the diversion was on.  Unfortunately, hourly diversion data were 

not available to me for the model validation period.  To evaluate more rigorously how 

accurate the validation simulations were, I calculated the difference in error between 

calibrated streamflow compared to measured streamflow at the Middle Fork stream gauge 

before and after adjusting for the diversion; the difference was 1.9%.   

 

4.4 Calibration and validation 

DHSVM is written in ANSI-C and requires a UNIX or LINUX platform.  I 

performed most simulations on a PC having dual 3 GHz processors and a Free BSD (UNIX) 

operating system.  Midway through model simulations, I changed to an Ubunto LINUX 

operating system.  Switching to LINUX had no effect on model results.  I calibrated the 

model to measured climate and streamflow data.  Following is a discussion of calibration 

and validation methods. 

 

4.4.1 Calibration  

 Calibration is the process whereby model input parameters are adjusted  so that 

simulated streamflow produced by the model is similar to measured streamflow from the 

Middle Fork gauging station from a specific time interval, thus ensuring that the model is 

estimating streamflow as accurately as possible (± 5%).  Although DHSVM is a physically 

based model, calibration is necessary because uncertainty exists in many of the required 

input parameters (Storck et al., 1995).  Calibration for this project required calibration of 
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simulated SWE to that measured at the Middle Fork SNOTEL station, and calibration of 

simulated stream discharge to that measured at the USGS gauging station. 

 The first step in calibration was setting initial conditions for the beginning of each 

simulation.  The initial conditions include the distribution of snow and water in the soil 

layers, vegetation layers, and ground surface (Storck et al., 1998).  To establish initial 

conditions, I began a DHSVM simulation with a dry watershed and ran the model using 

meteorological data from WY 2005.  It is important to use an entire year of meteorological 

data to establish the initial conditions to account for both dry and saturated conditions in the 

model state.  WY 2005 was an average precipitation year (Table 1).  I chose meteorological 

data from WY 2005 to establish the initial conditions to reduce the bias of an exceptionally 

wet or dry year.  The hydrologic conditions at the end of WY 2005 were then used as the 

initial conditions for all subsequent simulations.  

 DHSVM can distribute air temperature and precipitation in a variety of ways using 

lapse rates.  The temperature lapse rate dictates the cooling of an air mass with an increase 

in altitude.   Similarly, the precipitation lapse rate dictates the increase in precipitation with 

an increase in altitude as a result of adiabatic cooling of the air mass.  The simplest 

distribution method is using constant temperature and precipitation lapse rates.  

Alternatively, air temperature can be distributed over the basin using a variable temperature 

lapse rate, and precipitation can be distributed using the Parameter-elevation Regressions on 

Independent Slopes Model (PRISM) precipitation grids.  It has been observed during many 

DHSVM calibration experiments that air temperature decreases with altitude at different 

rates throughout the year (dry vs. wet lapse rate).  Typically, in the Pacific Northwest, lapse 

rates range from -4°C/km to during the winter months to around -9°C/km during the summer 
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months (Chennault, 2004).  Simulated results can depend to a large degree on the 

distribution methods that are used.  

 Shortwave solar radiation measurements are made at a point source, and DHSVM 

distributes the measurements with the use of monthly shading maps that are created using an 

ArcGIS AML script (Appendix A).  The shading files differ according to the time of year, 

time of day, and the topography surrounding the point source.  In this way, the amount of 

shading throughout the basin is accounted for, and DHSVM distributes short wave radiation 

values accordingly.  Longwave radiation is distributed over the basin uniformly, but is 

adjusted with the use of skyview maps that are also created using an ArcGIS AML script 

(Appendix A).  The skyview maps define the percentage of sky that is exposed to each pixel 

cell.  Relative humidity and wind speed are distributed uniformly over the entire basin. 

 I chose to calibrate DHSVM to WY 2005 due to the availability of diversion data.  

The Middle Fork experienced a number of high peak events as well as low summer 

streamflow, which provided a good test for model calibration.  During calibration, I 

generally altered one parameter per simulation to evaluate the effects of each parameter on 

streamflow.  The parameters that I concentrated on were temperature and precipitation lapse 

rates, snow/rain threshold temperatures, soil lateral hydraulic conductivity, and soil 

thickness (Appendix B).   

 DHSVM output consists of 42 parameters, and can be defined at any pixel for any 

time period.  The two model output parameters that I used for calibration were SWE in 

meters defined near the Middle Fork SNOTEL station, and hourly streamflow in cfs defined 

near the USGS stream gauging station (Figure 1, Table 4).  Output files were in ASCII 
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format.  I imported these files to my PC via Secure Shell (SSH), then imported them into 

Excel for analysis. 

 

4.4.2 Validation 

 Validation is the process whereby a calibrated model is used to simulate measured 

streamflow using a meteorological input file from a time period not included in the 

calibration. The simulated and measured streamflow for that period are then compared as a 

last assurance that the basin characteristics were established in the calibration process.  The 

validation period for this project was WYs 2003-2004, as the Middle Fork SNOTEL station 

has only been in operation since WY 2003.  The model is considered validated if the 

comparison between simulated and measured baseflow, peak events, and stream response 

time are comparable to that for the calibration application.  Although diversion data were not 

available for the validation time period, I still consider the model validated based on the 

requirements listed above, and the relatively minor effect of the diversion (see section 5.3.2).  

The diversion is most influential during the summer months, and does not affect peak 

streamflow or stream response times throughout most of the year. 

  

4.5 Simulating glacial melt  

 The aim of calibration is to capture the hydraulic properties of the Middle Fork basin 

as accurately as possible.  This includes the properties that control how and when snow 

accumulates throughout the year, and when snow and glaciers start and stop melting during 

the year.   
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 To simulate streamflow in the Middle Fork basin, it is important to understand how 

DHSVM simulates glacier ice melt.  Snow accumulation and melt are modeled with 

DHSVM using a two-layer energy and mass balance approach.  The two layers are a thin 

surface layer and a lower pack layer.  Each grid cell receives water in both liquid and solid 

forms (rain and snow) and the model determines the form of precipitation based on the air 

temperature.  During melt, the temperature of the snowpack is assumed to be isothermal at 

0°C (Chennault, 2004).   

 In DHSVM, the energy-balance components are used to simulate snowmelt, 

refreezing, and changes in the snowpack heat content (Wigmosta et al., 2002).  The energy- 

balance components include: net radiation flux (shortwave and longwave), sensible heat 

flux, latent heat flux, energy flux given to snowpack via rain and snow, and energy flux via 

refreezing and/or melting.  Energy exchange between the atmosphere and the snowpack 

takes place in the surface layer only.  Energy exchange between the two snowpack layers 

occurs from percolation of water from the surface layer to the lower pack layer and via ice 

exchange.  Energy exchange via conduction and diffusion between the layers is ignored. 

Measured (or estimated) shortwave radiation, longwave radiation, relative humidity, wind 

speed, precipitation, and air temperature, which are required input to DHSVM, are used to 

calculate many of the above energy components.     

 Mass-balance components are used to simulate snow accumulation and ablation, 

changes in snow-water equivalent, and water yield from the snowpack (Wigmosta et al, 

2002).  The snowpack is composed of two phases; water and ice.  Mass balance components 

include the volume per unit area of liquid water and the water equivalent of ice.  The 

atmosphere exchanges water vapor with the ice phase during non-melt periods and with the 
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liquid phase during melt periods (Wigmosta, 1994).  Mass is removed from the ice phase 

and added to the liquid phase during melting.  If the liquid phase exceeds the liquid water 

holding capacity of the thin surface layer, then excess water is drained into the pack layer 

(Wigmosta, 2002).  Similarly, if the ice phase exceeds maximum thickness of the surface 

layer, then it is distributed to the pack layer.   

 Glacial melt can be simulated using one of two methods in DHSVM.  Glaciers are 

modeled as an inexhaustible snowpack using the same two-layer mass and energy balance 

used to model snow melt.  An inexhaustible snowpack contains an infinite supply of water.  

The first method is to define vegetation type 20 as ‘Glacier’ in the input file.  When using 

this approach, the model maintains a SWE of 5 m for all cells defined as ‘Glacier’, and the 

SWE is re-set during times of glacial melt, ensuring that the glacier does not theoretically 

melt away during model simulation.  The second method is to define vegetation type 20 as 

‘Ice’ in the input file.  The model does not maintain a specified SWE throughout the melt 

period for all cells defined as ‘Ice’.  For my study, I used the former method, defining 

vegetation type 20 as ‘Glacier’. 

 Streamflow can be defined and evaluated at any pixel within the watershed.  When 

performing glacial melt experiments, one option is to define streamflow near the terminus of 

the glacier to better capture the effects of the glacier alone.  However, for this application, I 

chose to output streamflow at the USGS gauging station to be consistent with my calibration 

and validation experiments. 
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4.6 Glacial melt experiments  

Multiple episodes of glacier advance and retreat between the 15th and 20th centuries 

have been identified by moraine mapping and dating on Mt. Baker (Harper, 1992).  To 

evaluate the relationship between glacier size and runoff, I generated several vegetation 

grids representing different glacier coverages, both larger and smaller than the 2002 glacier 

coverage (Figures 8-10, Table 5).  The model was then used to predict future stream flow 

contribution based on potential glacial retreat, and to examine historic streamflow based on 

the magnitude of Deming, Twin Sisters, and Thunder Glaciers at their maximum LIA 

extents.   

 In addition to evaluating the relationship between glacier size and runoff, I examined 

simulated glacier discharge and total stream discharge resulting from different climate 

scenarios.  To account for the influence of climate change on glacier melt and total stream 

discharge, I performed experiments based on present climate conditions (WYs 2003-2005), 

and based on predicted and hypothetical climate conditions.   

 I performed the following experiments to evaluate the effects of glacier size and 

climate conditions on glacier melt and total stream discharge: 1) present climate conditions 

with different glacier coverages, 2) drought conditions with present glacier coverage,          

3) increased precipitation conditions with present glacier coverage, and 4) predicted climate 

with present and predicted glacier coverage.  Following is a discussion of the glacial melt 

experiments. 
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4.6.1 Present climate and different glacier coverages  

 I created vegetation/glacier grids representing glaciers larger (LIA) and smaller 

(future glaciers) than the present (2002) coverage.  Smaller glaciers estimates were based on 

the historic retreat rate of Deming Glacier.  I then performed model simulations to examine 

the relationship between glacier size and runoff with meteorological data for WYs 2003-

2005 as input.  Following is a discussion of the methods used to estimate the different 

glacier coverages and to quantify glacier melt.  

 

Future glacier sizes 

 I first attempted to establish the retreat rate of Deming Glacier since the LIA using 

moraine mapping and radiocarbon dating of buried logs.  LIA moraine mapping was 

performed with the help of Dr. Doug Clark using aerial photos, and was verified by field 

mapping.  In the field, we located several logs that were buried in till upstream of and 

underneath a terminal moraine complex, which is near the LIA terminal position (K. Scott, 

personal communication).  We collected four samples; two from the upstream location, and 

two from the downstream location (Figure 12).  The ages of the logs represent times when 

the trees were killed by the advancing glacier.  This in turn provides information about the 

extent and age of Deming Glacier during the Holocene.  After collecting the log samples, I 

selected small slivers of wood from near the outer surface of each.  This was done to ensure 

that the resulting dates were as representative of the time at which the tree died as possible.  

Initial sample preparation took place at Western Washington University following the 

standard procedures for Accelerator Mass Spectrometry (AMS) radiocarbon dating at 

Lawrence Livermore National Laboratory in Livermore, CA (Vogel, 1984).  
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  The AMS analyses indicate that the log samples are surprisingly old (2,960 ±30 and 

2,970 ±35 radiocarbon years for the upstream samples, and 2,440 ±30 and 2,205 ±30 

radiocarbon years for the downstream samples; Figure 12), and were not in fact related to 

LIA moraines.  We interpreted this as an older moraine that was later overlain by the LIA 

moraine, with no evidence of a soil horizon between the two.  Because the logs were from 

an older advance, they were not useful for determining a retreat rate between the LIA and 

present. 

 As an alternative method, I established the average linear retreat rate of Deming 

Glacier since its LIA maximum extent using glacier extent and age data from Fuller (1980).  

Using digital aerial photos overlain by the 2002 landcover grid in ArcGIS, I located the LIA 

terminus that Fuller mapped and used the ArcGIS measuring tool to determine the linear 

distance between the LIA terminus and 2002 terminus.  Using Fuller’s dates and the distance 

that I measured, the resulting retreat rate is 5.4 m/yr.  I applied the linear retreat rate to 

create several GIS grids representing possible future glacier scenarios (Figures 8-10).  The 

reoccupation of vegetation in recently deglaciated terrain is assumed to have a negligible 

effect on the hydrologic response of the watershed, and all deglaciated pixels were therefore 

modeled as the “Bare” vegetation class (Chennault, 2004).  Appendix A details the GIS 

methods used to create these grids. 

 I apply a conservative (slower), constant retreat rate (from LIA max to present) as 

opposed to the recent rapid retreat rate (during the past 30 years) in order to avoid over-

emphasizing effects of short-term climate variability.  Other scenarios are certainly possible. 

The glacier grids that I created are based on a conservative retreat rate (5.4 m/yr), assuming 

continuous linear retreat, which integrates across several high-frequency episodes of 
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advance and retreat that have occurred between the glaciers’ maximum LIA extent and now 

(Harper, 1992).  This method is only a first-order attempt to predict future glacier behavior.  

A more detailed attempt to predict future glacier behavior is beyond the scope of this thesis.    

  

LIA glacier sizes 

 I created a GIS vegetation grid representing a reconstruction of the LIA glacier 

extents with the help of Dr. Doug Clark (Figure 10).  We used a stereo pair of aerial photos 

to map out LIA moraines for the Deming, Twin Sisters, and Thunder Glaciers.  Although the 

LIA extent of the terminal tongue of Deming Glacier is fairly well constrained by well-

defined terminal moraines and changes in tree size, the Twin Sisters and Thunder Glaciers 

have not been studied in as much detail.  This is only a first-order approximation of the LIA 

maximum extent of Deming, Twin Sisters, and Thunder Glaciers.  A more rigorous 

reconstruction is beyond the scope of this thesis.   

 

Quantifying glacial melt 

 As mentioned above, many studies have compared two basins with similar 

hydrologic characteristics with the exception that one basin is glaciated and the other is not.  

The difference in streamflow in the two basins is assumed to be the direct result of glacial 

melt.  In this way, glacial contribution to streamflow can be evaluated.  The same concept 

applies to this application of DHSVM.  To quantify the present glacial meltwater component 

of streamflow, I created a vegetation grid in which all grid cells previously defined as 

‘Glacier’ were reclassified as ‘Bare’ (Figure 11).  I then applied DHSVM to simulate 

streamflow in two basins having not only similar, but identical hydrologic properties with 
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the exception that one is glaciated and the other is not.  This approach therefore has the 

potential for improved results compared to the side-by-side studies because it eliminates the 

uncertainties related to the variability between any two basins. 

 

4.6.2 Drought and increased precipitation scenarios 

 I created the synthetic drought and increased precipitation input files using a 

compilation of the three years of meteorological data that were used for calibration and 

validation.  I created the drought file by inputting the driest meteorological data for each 

month.  For example, I chose the driest October out of the three years, followed by the driest 

November, and so on.  I then copied this one year of dry climate four times, resulting in a 

five year input file of hypothetical drought conditions.  I used the same method for the 

increased precipitation file, with the exception that all data were the wettest for each month.   

 The glacial meltwater component of streamflow was determined using the same 

method that was used for present climate conditions (glaciated vs. non-glaciated basin).  

Potential increase/decrease in streamflow was determined by comparing streamflow for the 

drought and increased precipitation scenarios to streamflow based on present climate 

conditions. 

 

4.6.3 Predicted climate change for the Pacific Northwest 

 I created a three-year meteorological input file based on predicted climate change in 

the Pacific Northwest.  The Climate Impacts Group out of the University of Washington has 

performed numerous model simulations and has reviewed model simulations from around 

the world for predicting local climate change (Climate Impacts Group, 2004).  Based on 
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their synthesis of the results of these model simulations, I chose to use an average increase 

in temperature of 1.4°C (October-March) and 1.8°C (April-September) and an increase in 

precipitation of 5% (October-March) and a decrease in precipitation of 4% (April-

September).  Using these predictions, I simply modified the meteorological data sets that I 

used for calibration and validation, resulting in a three-year predicted meteorological input 

file. 

 The glacial meltwater component of streamflow was determined using the same 

method that was used for other climate conditions (glaciated vs. non-glaciated basin).  

Potential increase/decrease in streamflow was determined by comparing streamflow for the 

predicted climate scenario to streamflow based on present climate conditions. 

 

5.0 RESULTS AND DISCUSSION  

 The majority of the effort put into this project was dedicated to data collection, GIS 

grid generation for basin set-up, and model calibration and validation.  After the model was 

successfully calibrated, I applied the model to examine the contribution of glacial meltwater 

to streamflow in the Middle Fork Nooksack River based on a variety of scenarios including 

variable glacier coverage and present and predicted climate.   

 Final products of this thesis include: a calibrated and validated DHSVM model of the 

Middle Fork Nooksack River basin which will serve as a basis for future modeling of 

glaciers on Mt. Baker; quantified present glacial meltwater component of streamflow in the 

Middle Fork; and simulated streamflow based on predicted climate scenarios and present 

glacier coverage.  Following is a discussion of the results of my work.  
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5.1 Basin setup 

 Basin setup included the generation of five GIS input grids that were clipped to the 

watershed boundary (Appendix A).  The data used to create these grids were the most recent 

data available at the time of this thesis.  However, as updated data become available, new 

GIS grids can be created which can easily be incorporated into the model. If the data are 

better, the simulations should better approximate observed conditions.  This model can 

therefore serve as a basis for future modeling studies of the hydrology in the Middle Fork 

Nooksack basin. 

 

5.2 Meteorological data 

 The data file that I created to represent the meteorology of the Middle Fork 

Nooksack basin is comprised of a three-year time series of precipitation and air temperature 

obtained from the Middle Fork SNOTEL station, and wind speed, long and shortwave 

radiation, and relative humidity from the North Shore climate station near Lake Whatcom in 

western Whatcom County, WA.  One of the challenges of this project was due to the fact 

that the latter meteorological parameters are not recorded within or even near the Middle 

Fork basin.  Precipitation and air temperature are the most influential factors in modeling the 

hydrology of the Middle Fork basin.  Precipitation dictates discharge volume, while the air 

temperature determines whether precipitation falls as snow or rain.  The other 

meteorological parameters primarily control the timing of runoff.  It is more essential that 

the meteorological input file contains local precipitation and temperature data; however, it is 

desirable that the other parameters be recorded at a station nearer to the study area.  Again, if 
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newer data become available in the future, they can easily be incorporated into the model 

framework that I have created.     

 

5.3 Calibration and validation 

 Continuous streamflow, diversion, and meteorological data allowed for this 

calibrated and validated hydrologic model of the Middle Fork Nooksack basin to be created.  

To complete calibration and validation, I performed 56 model simulations.  Combined, these 

simulations took approximately 80 hours of computer run-time.  Following is a discussion of 

the results of these model simulations.  

 

5.3.1 Calibration 

 The primary focus of this application of DHSVM was to calibrate simulated 

streamflow to streamflow measured at the USGS gauging station.  A secondary, but equally 

important objective was to calibrate predicted SWE to that measured at the Middle Fork 

SNOTEL station.  Calibration of SWE was completed to determine the appropriate rain and 

snow threshold temperatures.  Calibration of the model to streamflow was then performed to 

isolate precipitation and temperature lapse rates, soil thickness, and soil lateral hydraulic 

conductivity.  I generally examined the effect of altering one of the above parameters at a 

time.  See Appendix B for a description of all simulations performed.  

 

Meteorological stations 

 I first attempted model calibration using meteorological input files from Elbow Lake, 

Wells Creek, and Middle Fork SNOTEL sites.  Calibration using this method proved to be 
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more complicated than anticipated.  The Middle Fork SNOTEL station was installed with 

the intention of monitoring the Middle Fork basin (J. Greenberg, personal communication).  

For this reason, I decided that precipitation and temperature data from the Middle Fork 

station would best represent the meteorology in the basin.  See Table 1 for a summary of 

temperature and precipitation values used as input, and Appendix B for a description of 

calibration simulations performed with three meteorological input files. 

 

USGS Streamflow 

 I first performed a simulation using DHSVM default parameters (Figure 13).  The 

model underestimated measured peaks and baseflow (-43 % error).  To improve simulation 

results, the first parameter that I examined was soil thickness.  I created a series of soil 

thickness grids representing soils ranging in thickness from 0.76-1.5 m, 1.0-2.5 m, and 1.0-

3.5 m.  I found that DHSVM was not particularly sensitive to soil thickness in the Middle 

Fork basin (Figure 14), but the model most accurately predicted late-summer stream 

discharge using soils ranging in thickness from 1.0-2.5 m.  I also adjusted the lateral 

hydraulic conductivity (KL) of the most prominent soil type in the basin and found that 

DHSVM was most accurate using KL of 0.005 m/s. 

 During the calibration process, I discovered that DHSVM was particularly sensitive 

to precipitation lapse rate.  Using the default lapse rate of 0.0010 m/m, the model greatly 

underestimated baseflow and storm-event peaks (Figures 13 and 15).   DHSVM responded 

to an increase in precipitation lapse rate in a manner opposite of that which was expected.  

An increase in the precipitation lapse rate corresponded to a further decrease in baseflow 

and storm-event peaks.  A possible explanation for this observation is that the Middle Fork 
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SNOTEL station is located at a high altitude relative to the Middle Fork basin (Table 4).  

Precipitation increases with an increase in altitude at the same rate that precipitation 

decreases with a decrease in altitude.  Therefore, it is reasonable that in increase in the 

precipitation lapse rate at the high altitude SNOTEL station would correspond to an overall 

decrease in streamflow.  In order to accurately simulate streamflow in the Middle Fork, I 

decreased the precipitation lapse rate by an order of magnitude (Figure 15). 

 I evaluated the influence of various temperature lapse rates to determine whether a 

constant or variable lapse rate was more appropriate for modeling streamflow in the Middle 

Fork.  Temperature inversions are common in the Middle Fork basin, making it very 

difficult to establish a consistent temperature lapse rate (J. Greenberg, personal 

communication).  I found that the most appropriate temperature lapse rate was variable and 

equal to -0.0060 °C/km for November through June, and -0.0090 °C/km for July through 

October (Figure 16). I used this variable temperature lapse rate for all subsequent 

simulations. Similar temperature lapse rates have been used to simulate streamflow in the 

Pacific Northwest (Chennault, 2004).   

 

Snow-water equivalent 

 After establishing the appropriate soil thickness, lateral hydraulic conductivity, 

precipitation lapse rate, and temperature lapse rate, DHSVM was able to accurately simulate 

streamflow for the months October-May, but greatly underestimated summer streamflow 

(Figure 17).  The model was not producing enough snowpack throughout the year.  To 

address this problem, I evaluated the model’s sensitivity to the snow and rain threshold 

temperatures in the basin.  I then compared predicted SWE defined at the Middle Fork 
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SNOTEL station to that which was observed at the station (Figure 18, Table 6).  DHSVM 

modeled an increase in SWE through the month of April.  A decrease in SWE commences in 

May, as does measured SWE (Figure 18; Table 6).  However, the modeled snow does not 

completely melt during the summer as it does at the Middle Fork SNOTEL station.  

DHSVM was best able to simulate SWE with a snow and rain threshold temperature of 4°C.  

Although this seems high, the subsequent simulations produced enough snow-pack that 

predicted summer streamflow matched closely with measured streamflow.   

 Using the above parameter values, the model was considered calibrated with a 2.1 % 

error between total simulated and total measured streamflow (Figure 19).   

 

5.3.2 Validation and potential errors 

 Model validation is performed to ensure that the model can accurately simulate 

streamflow using meteorological data sets different from those used for calibration.  I 

validated the model for the Middle Fork using meteorological data from WYs 2003 and 

2004.  Validation simulation results are shown as stream hydrographs compared to measured 

streamflow (Figures 20 and 21) and as bar graphs representing total annual stream discharge 

(Figure 22).  As previously stated, for the calibration simulation, I compared simulated 

streamflow to measured streamflow both before and after adjusting for the diversion.  I 

found that the model under-predicted streamflow by 2.1% when accounting for the 

diversion, and by 0.18% without accounting for the diversion.  The error is increased when 

accounting for the diversion because the under-prediction of summer streamflow is even 

more exaggerated when diversion values are added back in to measured streamflow.   
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 The model is considered validated based on similarity to calibration results, and     

±4 % error between measured and simulated streamflow (Figures 20 and 21).  As with the 

calibration simulation, storm-event peaks are generally under-predicted (assuming that 

measured peaks are reasonable), while baseflows generally agree with measured streamflow.  

All simulations show a slight under-prediction of summer streamflow (Figures 20 and 21).  

The error for the WY 2004 validation simulation is higher as a result of the high measured 

summer peak flows.  Although the model is considered calibrated and validated, it is 

important to consider several potential errors associated with both measured and simulated 

data, and possible explanations for discrepancies between the two.  Following is a discussion 

of potential errors. 

 

Measured Streamflow 

 Streamflow discharge records for the Middle Fork are considered by the USGS to be 

‘fair’ to ‘good’, except for discharges above 4000 cfs which are considered ‘poor’ (USGS, 

2005).  Discharges greater that 3,800 cfs are not directly measured, but are estimated by 

extending the stage-discharge rating curve using indirect measurements of peak events.  This 

in turn can lead to significant errors in peak discharge values above 4,000 cfs.  Peak 

discharges greater than 4,000 cfs occur frequently for the Middle Fork Nooksack River 

(Figures 19-21).   

 

Middle Fork SNOTEL snow-water equivalent 

 Errors may be associated with the instrumentation used to collect SWE, air 

temperature, and precipitation data at the Middle Fork SNOTEL station.  Basic 
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instrumentation used by the Natural Resources Conservation Services (NRCS) includes a 

pressure sensing snow pillow, storage precipitation gage, and air temperature sensor.  The 

pressure-sensing snow pillow is a rubber membrane that contains a liquid with a low 

freezing point.  Weight of snow on the pillow controls the pressure of the liquid which is 

recorded via a pressure transducer (Dingman, 2002).  Several factors may affect the 

accuracy and continuity of the measurements including: variability of the instrument’s liquid 

density due to changes in air temperature and atmospheric pressure, ice layers within the 

snowpack which act to ‘bridge’ the snow from the instrument and may lead to an 

underestimation of snowpack, leakage of measurable precipitation, and unstable power 

sources.  However, NRCS snow-water equivalent data are considered to be accurate to 

within 2.5 mm.   

 As mentioned previously, precipitation and air temperature are required input for 

DHSVM, and these data are used to simulate SWE in the basin.  The most prevalent source 

of error associated with the precipitation gauge is the result of wind, leading to an 

underestimation of snowpack.   

 

Simulated snow-water equivalent 

 Several possible sources of error exist in the assumptions made to simulate SWE 

within DHSVM.  In order for DHSVM to produce enough snowpack throughout the year for 

this application, I was forced to increase the maximum temperature at which snow occurs, 

and increase the minimum temperature at which rain occurs in the Middle Fork basin to 4°C. 

This value is rather high and may not be realistic.  It may also be unreasonable to assume 

that the rain/snow threshold temperature is constant throughout the year.  In addition, the 
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snow water capacity is user-defined in DHSVM.  I used the default setting of 0.30 

(snowpack is 30% water), but this is not well constrained.   

 

Simulated glacial melt 

In order for snow to commence melting in DHSVM, the entire snowpack must be 

isothermal at 0°C as well as completely saturated (Chennault, 2004).  Warming of the 

snowpack by infiltration is unrealistic when applying the two layer model to a glacier.  

However, this should not be a problem in this case because most North Cascades glaciers 

are believed to be at or near isothermal conditions (D. Clark, personal communication). The 

inexhaustible snowpack method for estimating glacial meltwater is only appropriate for 

short-term modeling because simulated glaciers continue to produce melt water under the 

right conditions while maintaining their original areal extent.  DHSVM does not simulate 

glacial retreat, and is therefore not appropriate for long-term modeling (a time period in 

which a glacier retreats significantly).   

Another factor to consider when simulating glacial meltwater is basal melting.  

DHSVM does not account for basal pressure melting, which may contribute up to 10% of 

glacial meltwater on average for temperate mountain glaciers (Benn and Evans, 1998).  This 

may or may not significantly affect glacial melt estimations, but should be considered 

nonetheless.  

Although many possible sources of error exist for both the measured and simulated 

data, it is important to note that a major assumption for this application of DHSVM is that 

the measured values are accurate, and it is therefore reasonable to calibrate the model to the 

measured values. 
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5.4 Glacial melt experiments 

 The primary purpose of this thesis was to quantify the present glacial meltwater 

component of streamflow in the Middle Fork Nooksack River and to examine the 

relationship between glacier size and glacier runoff.  I conducted a series of model 

simulations to examine the influence of the glacial meltwater on overall streamflow in the 

Middle Fork under a variety of climatic conditions including present conditions (WYs 2003-

2005), drought, increased precipitation, and predicted climate change.  Following is a 

discussion of the results of each of these experiments. 

 

5.4.1 Present climate and different glacier coverages 

 To quantify the present glacial meltwater component of streamflow in the Middle 

Fork Nooksack River, I applied DHSVM using the calibrated model, three years of 

meteorological data that were used for model calibration and validation (WYs 2003-2005), 

and the vegetation/glacier grid representing Deming, Twin Sisters, and Thunder Glaciers at 

their 2002 extent (3.1% glacier coverage, Table 5).  I then applied DHSVM to simulate 

streamflow using the same parameters but using the vegetation/glacier grid representing 0% 

glacier coverage (Figure 11).  The difference in streamflow between the two simulations is 

glacial meltwater (Figure 23).  I proceeded to perform simulations using the same input 

files, but with vegetation grids representing different glacier coverages to examine the 

relationship between glacier size and runoff.  I compared all simulated streamflow to that 

which was simulated using the 0% glacier coverage grid (Figures 23-26).   
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Glacial meltwater contributions to streamflow  

 The glacial meltwater component of streamflow with the 2002 glacier coverage 

varied depending on the climate of a given year, and ranged from 1.5% to 2.3% annual 

contribution, and 8.4% to 26.1% late-summer contribution (Table 7).  A 17% reduction in 

glacier size (predicted for year 2050) corresponds to meltwater contribution between 0.8% 

and 1.3% annual contribution, and between 6.9% and 19.2% late-summer contribution 

(Table 7).  A 48% reduction in glacier size (predicted for year 2150) corresponds to 

meltwater contribution between 0.2% and 0.4% annual contribution, and between 1.8% and 

8.3% late-summer contribution (Table 7).  A 144% increase in glacier size (estimated for 

LIA maximum extent) corresponds to meltwater contribution between 7.6% and 10.8% 

annual contribution, and between 27.5% and 56.8% late-summer contribution (Table 7).    

 The meltwater component of streamflow with the various glacier sizes consistently 

decreased relative to glacier size (Figure 27).  The range in the glacial meltwater 

contribution to streamflow for the simulations above can be explained by the variability in 

temperature, precipitation, and SWE for the three years of meteorological data used as 

model input (Figure 28, Table 1).  DHSVM consistently simulated the highest percent 

contribution of glacial meltwater using meteorological data from WY 2003, which was the 

driest of the three years (Precipitation = 2.4 m; Table 1).  It also consistently simulated the 

lowest percent contribution using meteorological data from WY 2004 which had the most 

overall precipitation of the three years of input (Precipitation = 3.1 m; Table 1).  This makes 

physical sense because overall input to the stream during a dry year is lower than that for a 

year with more precipitation.  Therefore, the glaciers will have more of an effect during a 

dry year, while the effect will be dampened during a wet year.  However, results were not 
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necessarily consistent on the sub-yearly basis, depending on the distribution of precipitation 

throughout each year (Figure 28, Table 1).  For example, summer meltwater contribution 

was lowest for WY 2005 as the result of high summer precipitation (June and July) relative 

to WYs 2003 and 2004 (Table 1). 

 Among all glacial melt experiments, the highest percent contribution of glacial 

meltwater to streamflow occurs during late-summer, while the lowest occurs annually 

(Table 7).  This is due to the seasonal distribution of precipitation (Table 1) and the fact that 

the glaciers only melt during the summer months.  Also, overall input to the stream is lowest 

during late-summer when precipitation is low and most of the snow in the basin has already 

melted, thus compounding the glacial effect. 

 The glaciers with the largest surface area consistently began melting earliest in the 

year, whereas the glaciers with the smallest surface area began melting latest in the year 

(Figures 23-27, Table 7).  Similarly, the larger glaciers continued melting later in the year 

than the smaller glaciers.  This result can be explained by the fact that I have forced a larger 

glacier to exist at lower altitude under present climate conditions for these simulations.  For 

example, the LIA glacier extends deeper in the valley and to a lower altitude than that which 

naturally occurs with present climate conditions.  As a result, the glacier at the lower 

elevation (LIA glacier) begins melting earlier in the year than the modern glacier (2002 

coverage) that exists under present climate conditions.  Among the different glacier sizes, 

the date when melting begins varies from April 24th to July 23rd (Figures 23-27, Table 7).  

The latest dates that the variable glaciers stopped melting range from October 6th to 

November 7th (Table 7).     
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 Results of the variable glacier simulations agree with previous studies (i.e., 

Chennault, 2004; Pelto 2003).  Chennault (2004) found that larger glaciers contribute more 

to streamflow and begin to melt earlier in the season than smaller glaciers. He also found 

that the amount of precipitation during a given year greatly influences the degree to which a 

glacier affects overall streamflow.  Pelto (2003) concluded that meltwater from the Deming 

Glacier could contribute up to 30% of streamflow in the Middle Fork Nooksack River 

during the late-summer. Similarly, results of my study indicate that during a dry year (WY 

2003), glacial meltwater may contribute approximately 26% of late-summer streamflow.  

 

Change in glacier discharge compared to 2002 glacier coverage 

 Using meteorological data for WYs 2003-2005 (the same used for model calibration 

and validation) and 2002 glacier coverage, cumulative simulated glacier discharge ranged 

from 6.95x106 m3 to 1.15x107 m3 (Table 8).  After calculating the cumulative glacier 

discharge for each of the various glacier coverages, I compared the resulting discharge to 

that for 2002 glacier coverage. Following is a discussion of the results of the variable glacier 

simulations. 

 A 17% reduction in glacier size (predicted for year 2050) corresponds to a decrease 

in glacier discharge between 40.2% and 45.9% compared to 2002 glacier coverage.  

Similarly, a 48% reduction in glacier size (predicted for year 2150) corresponds to a 

decrease in glacier discharge between 82.7% and 87.3% (Table 8).  Simulated data suggest 

that a 144% increase in glacier size and present climate conditions would result in an 

increase in glacial discharge between 347.1% and 435.3%. However, it must be noted that 
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the latter estimation is not realistic, as glaciers as large as those during the Little Ice Age 

could not exist under present climate conditions.   

 

Change in stream discharge compared to 2002 glacier coverage 

 Because the City of Bellingham diverts water from the Middle Fork just below the 

USGS stream gauge, it is important to consider how the different glacier sizes affect overall 

streamflow, and not only glacier discharge.  Cumulative stream discharge modeled at the 

USGS gauging station ranged from 4.18x108m3 to 5.45x108 m3 for present climate 

conditions and 2002 glacier coverage (Table 9).  Using results of model simulations, I 

calculated streamflow (defined at the USGS gauging station) for each of the various glacier 

scenarios and compared the results to that for 2002 glacier conditions.  This manipulation 

was performed to examine how an increase or decrease in glacier size would affect total 

stream discharge for annual, summer, and late-summer time periods (Table 9). 

 A 17% reduction in glacier size (predicted for year 2050) corresponds to a decrease 

in annual cumulative stream discharge between 0.67% and 1.05% compared to 2002 glacier 

coverage.  Similarly, a 48% reduction in glacier size (predicted for year 2150) corresponds 

to a decrease in annual stream discharge between 1.28% and 2.07% (Table 9).  Simulated 

data suggest that a 144% increase in glacier size and present climate conditions would result 

in an increase in annual stream discharge between 6.67% and 9.46%.  Again, the latter 

estimation is not realistic because the simulation was performed with LIA glacier coverage 

and present climate conditions.  These two conditions can not exist in nature simultaneously. 

 The maximum decrease in annual and late-summer stream discharge consistently 

occurs with the water year 2003 meteorological input file for all glacier scenarios.  This 
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observation can be explained by the fact that WY 2003 had the least precipitation (Table 1), 

and therefore it is the year that is most sensitive to a change in glacial meltwater input.  The 

maximum difference in stream discharge consistently occurred during the late-summer 

(Table 9).  Again, late-summer is when the glaciers significantly affect streamflow due to 

lower overall stream inputs and maximum glacial melt.   

 

5.4.2 Drought scenario and 2002 glacier coverage 

 For the drought scenario simulations, I created a five-year input file using the same 

year of hypothetical drought conditions five years in a row (see section 4.6.2) to examine 

how drought affects the glacial component of streamflow in general, and to examine 

compounding effects of several years of drought.  Following is a discussion of the results of 

the drought simulations. 

 

Glacial meltwater contributions to streamflow  

 Simulated stream discharge ranged from 3.64x108 m3 during the first year of drought 

to 3.51x108 m3 during the fifth year of drought (Table 10).  The higher discharge during the 

first year can be explained by the fact that the initial conditions for the 5-year drought 

simulation were defined as the end of WY 2005 (Appendix B).  Therefore, more water was 

stored in the soil at the beginning of the simulation than at the end of any drought year 

simulation, resulting in a higher discharge for the first year.  Glacial meltwater contribution 

increased slightly from 2.91% during the first year to 3.20% during the fifth year of the 

drought simulation (Table 10).  Late-summer contribution increased from 21.4% for the first 

year to 32.0% during the fifth year of the drought simulation (Table 10).  The most probable 
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explanation for this is that water which was stored in the soil decreased for each year of 

drought, resulting in less overall input to the stream via groundwater and an increase in the 

glacial meltwater component of streamflow.  

 

Change in glacier discharge compared to present conditions 

 Using meteorological data for WYs 2003-2005 (the same used for model calibration 

and validation) and 2002 glacier coverage, simulated cumulative glacier discharge ranged 

from 6.95x106 m3 to 1.15x107 m3 (Table 8).  After calculating the cumulatiave glacier 

discharge for the drought scenario, I compared the resulting discharge to that for present 

climate conditions (WYs 2003-2005).  2002 glacier coverage was used for all simulations.  

Following is a discussion of the results of the drought condition simulations. 

 The drought scenario corresponds to a change in glacier discharge between -4.3% 

and +59.7% compared to present climate conditions (Table 11).  For these comparisons, the 

first year of drought was compared to WY 2003, the second year of drought was compared 

to WY 2004, and the third year of drought was compared to WY 2005.  It makes sense that 

glacier discharge is generally increased for the drought scenario compared to present climate 

conditions because less snow is produced during a drought, and the snowpack therefore 

melts off earlier promoting earlier melting of the glacier and increased glacier discharge. 

 

Decrease in stream discharge compared to present conditions 

 As previously mentioned, the City of Bellingham diverts water from the Middle Fork 

and it is therefore important to consider how a drought scenario would affect overall 

streamflow, and not only glacier discharge.  I compared streamflow from drought 
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simulations to streamflow based on present climate conditions (WYs 2003-2005).  2002 

glacier coverage was used for all simulations.  Following is a discussion of the results of the 

drought simulations.  

 Drought conditions correspond to a decrease in annual stream discharge between 

12.8% and 35.5% compared to present climate conditions (WY 2003-2005; Table 12).  The 

decrease in late-summer stream discharge for drought simulations varies from 9.6% to 

67.6% compared to present climate conditions (Table 12).  This range in values is a function 

of comparing fairly consistent simulated data to streamflow data simulated for three 

different water years.  For example, the streamflow for the first year of drought is compared 

to streamflow for WY 2003, streamflow for the second year of drought is compared to 

streamflow for WY 2004, and streamflow for the third year of drought is compared to 

streamflow for WY 2005. 

 The maximum decrease in summer and late-summer stream discharge consistently 

occurs with the water year 2004 meteorological input file for all glacier scenarios.  Again, 

WY 2004 had the most precipitation of the three years used for meteorological input (Table 

1).  It makes physical sense that the largest difference in streamflow results from comparing 

a drought simulation to the wettest water year.  The maximum decrease in stream discharge 

generally occurs during late-summer (Table 12).  The decrease in late-summer streamflow is 

primarily a function of decreased precipitation and therefore less overall input to the stream, 

and not a function decreased glacier discharge.  
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 5.4.3 Increased precipitation scenario and 2002 glacier coverage 

 As with the drought simulations, I used a one-year meteorological input file 

representing increased precipitation five years in a row (see section 4.6.2) to evaluate the 

effect of increased precipitation on the glacial component of streamflow, and to examine 

compounding effects of several consecutive years of increased precipitation.  I then 

compared streamflow for the increased precipitation scenario to streamflow for present 

climate conditions (WYs 2003-2005).  2002 glacier coverage was used for all simulations.  

Following is a discussion of the results of the increased precipitation simulations. 

 

Glacial meltwater contributions to streamflow 

 For the 5-year increased precipitation scenario, cumulative simulated stream 

discharge ranged from 6.52x108 m3 for the first year, and reached a plateau at 6.43x108 m3 

for the following four years (Table 13).  The glacial meltwater component of streamflow 

was 0.8% for all five years, while the late-summer component was 4.3% for all five years. 

There was no evident variability or compounding effect of multiple years of increased 

precipitation on glacier meltwater contribution to streamflow.  The glaciers consistently 

began melting on June 15th or 16th, and stopped melting on October 18th.   

 

Change in glacier discharge compared to present conditions 

 As with the drought simulations, I compared glacier discharge simulated for the 

increased precipitation scenario to that for present climate conditions (WYs 2003-2005).  

2002 glacier coverage was used for all simulations.  Following is a discussion of the results 

of the increased precipitation simulations. 
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 The increased precipitation scenario corresponds to a decrease in glacier discharge 

between -27.3% and -56.0% compared to present climate conditions (Table 14).  Again, for 

these comparisons, the first year of increased precipitation was compared to WY 2003, the 

second year of increased precipitation was compared to WY 2004, and the third year of 

increased precipitation was compared to WY 2005.  It is reasonable for glacier discharge to 

decrease for the increased precipitation scenario compared to present climate conditions 

because more snow is produced during this scenario; the snowpack takes longer to melt off, 

and therefore results in a shorter glacier melt period and decreased glacier discharge (Table 

13 and 14). 

 

Increase in stream discharge compared to present conditions 

 Simulated stream discharge was consistently higher for the increased precipitation 

scenario than that simulated for present climate conditions (WYs 2003-2005; Table 15). 

Because stream discharge was the same for four of the five years simulated, I compared the 

simulated streamflow to that simulated for each year of present climate conditions (WYs 

2003-2005).  Late-summer stream discharge increased by 195.2% compared to WY 2003, 

by 7.8% compared to WY 2004, and by 106.7%compared to WY 2005 (Table 15).  This is 

reasonable because WY 2004 was the wettest of the three years of present climate, while 

2003 was the driest (Table 1).  It is expected that the effect of increased precipitation would 

be reduced when compared to a wet year and amplified when compared to a dry year. 
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5.4.4 Predicted climate scenario with 2002 and predicted 2050 glacier coverages 

 The meteorological input file that was created for the predicted climate simulations 

was based on modeled climate change for the Pacific Northwest for the 2040s and 2050s 

(Climate Impacts Group, 2004).  Because climate data were modified to simulate future 

climate, I applied DHSVM to examine the glacial meltwater contributions based on present 

glacier conditions (2002 coverage) and predicted glacier coverage for the same time period 

(17% reduction; year 2050).  I compared total streamflow and the glacial meltwater 

component of streamflow to that simulated using present climate conditions (WYs 2003-

2005) and like glacier coverages.  Following is a discussion of the results of each of these 

simulations. 

 

Glacial meltwater contributions to streamflow 

 For the 5-year predicted climate scenario and 2002 glacier coverage, cumulative 

simulated stream discharge ranged from 4.4x108 m3 to 5.7x108 m3 (Table 16).  The glacial 

meltwater component of streamflow ranged from 2.2% to 3.3%.  The late-summer meltwater 

component was consistently higher and ranged from 11.3% to 33.7% (Table 16).  As 

expected, DHSVM consistently simulated lower overall streamflow and glacial meltwater 

contribution for the smaller glacier coverage. 

 Glaciers began melting earlier in the year for the predicted climate scenario, and 

continue melting later into the year than under present climate conditions. One explanation 

for this observation is that increased summer temperatures promoted the longer melting 

season.  
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Change in glacier discharge compared to present conditions 

 To evaluate the effect of predicted climate change on glacial melt, I compared 

glacier discharge simulated for the predicted climate scenario to that for present climate 

conditions (WYs 2003-2005).  I simulated glacial melt using 2002 and 2050 (17% 

reduction) glacier coverages.  Following is a discussion of the results of the predicted 

climate simulations. 

 The predicted climate scenario corresponds to an increase in glacier discharge 

between 33.9 and 60.4% for 2002 glacier coverage, and between 52.8 and 69.3% for 2050 

glacier coverage; all simulations were compared to present climate conditions (Table 17).  It 

makes sense that glacier discharge increases for the predicted climate scenario compared to 

present climate conditions because although winter precipitation is greater, higher summer 

temperatures and decreased summer precipitation promote earlier melting of the glacier, 

similar to that for the drought simulations.  The longer glacier melt period (Table 16) and 

increased temperatures (Table 1) result in increased glacier discharge. 

 

Change in stream discharge compared to present conditions 

 Annual stream discharge was higher for the predicted climate scenario than for 

present climate conditions for all simulations (Table 18).  However, summer and late-

summer streamflow is lower for the predicted climate scenario than for present climate 

conditions.  As mentioned previously, it has been predicted that temperatures will increase 

by 1.4°C (Oct-Mar) and 1.8°C (Apr-Sep) and precipitation will increase by 5% (Oct-Mar) 

and decrease by 4% (Apr-Sep) (Climate Impacts Group, 2004).  Resulting simulated data 

agree; more precipitation falls in the form of rain, there is more precipitation overall, but less 
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during the summer.  Therefore, it makes sense that overall stream discharge increases while 

summer and late-summer streamflow decrease.  In addition, because precipitation was 

multiplied by a percentage to create the predicted climate file, each meteorological data set 

responds differently.  For example, precipitation for the wettest year, WY 2004, will be even 

more exaggerated by the increase in precipitation of 4% than WY 2003, in which the 

increase in precipitation is dampened.    

 

5.4.5 Summary of glacial melt experiments 

 Present (WY 2003-2005 and 2002 glacier coverage) late summer glacial meltwater 

contribution to streamflow in the Middle Fork Nooksack River is estimated between 8.4% 

and 26.1% (Table 7).  The glacial meltwater component of streamflow as a percentage 

depends on the total streamflow in a given year.  For example, a glacier contributes a higher 

percentage to streamflow during a dry year when overall stream input is lower. During a wet 

year, when the watershed is more snow-dominated or simply has more overall water input, 

the effect of the glacier is reduced.  Larger glaciers consistently contributed more to 

streamflow than smaller glaciers (Table 7).  The larger glaciers began melting earlier in the 

year and stopped melting later in the year; the smaller glaciers had a shorter melting season 

than the larger glaciers.   

 Glacier meltwater contribution to streamflow for the drought simulations was 

consistently higher than that for present (“average”) climate conditions and increased 

throughout the five year drought period for annual and sub-annual calculations.  The glaciers 

consistently began melting earlier in the year and stopped melting later in the year than 
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under present climate conditions.  Under the drought conditions, streamflow in the Middle 

Fork was simulated to decrease by approximately 9.6% to 67.6% during late-summer.   

 Glacier meltwater contribution for the increased precipitation simulations was 

consistently lower than that for present climate conditions.  Meltwater contribution to 

streamflow was highest for the first year of increased precipitation and then reached a 

plateau for remainder of the simulation period.  The glacier ‘melt period’ was similar to that 

for present climate conditions for all five years of the increased precipitation simulations.  

Under the increased precipitation conditions, streamflow in the Middle Fork was simulated 

to increase by approximately 18% to 56% for annual simulations and by approximately 8% 

to 195% during late-summer.  Again, because the original meteorological input data were 

multiplied by a percentage to simulate increased precipitation, each year of meteorological 

data behaved quite differently.   

 The glacier meltwater component of streamflow for the predicted climate 

simulations ranged from 11.3% to 33.7% during late-summer with 2002 glacier coverage.  

Glacier contribution was generally higher for this scenario than for present climate 

conditions (WYs 2003-2005).  Under the predicted climate conditions, streamflow in the 

Middle Fork was simulated to increase by approximately 3% to 5% for annual simulations 

and decrease by approximately 6% to 10% during late-summer.  The overall increase in 

stream discharge is the result of increased (and warmer) winter precipitation, while the 

decrease in summer stream discharge is the result of decreased summer precipitation.  The 

glaciers began melting earlier in the year and stopped melting later in the year than under 

present climate conditions as a result of increased precipitation in the form of rain and 

increased summer temperatures. 
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5.5 Implications 

A decrease in the glacial meltwater component of streamflow, especially during late-

summer, could have substantial implications for water resources in Whatcom County, WA.  

Water use is highest during late-summer when streamflow is lowest.  The city could 

potentially store excess water during the winter months to compensate for water shortages 

during the summer when demand is highest.  However, the city presently maintains the 

maximum storage capacity in Lake Whatcom in the spring, so any increased storage would 

require other storage facilities. 

Ecological issues such as salmon habitat and migration as well as flooding issues 

continue to govern Middle Fork water resources management.  These issues will likely 

become more problematic in the future, especially during late-summer, as a result of both 

climate change and glacier shrinkage.  The viability of the Middle Fork Nooksack diversion 

in the late summer may be compromised as a result of low stream discharge during that 

time. 

 

6.0 CONCLUSIONS  

 The major goals of this thesis were to quantify present glacial meltwater contribution 

to streamflow in the Middle Fork Nooksack River, and to examine the relationship between 

glacier size and runoff under a variety of climate conditions at annual and sub-annual time 

scales.  I accomplished this objective with the use of the Distributed Hydrology Soils 

Vegetation Model (DHSVM).  DHSVM simulates a water and energy balance at the pixel 

scale of a DEM.  All hydrologic parameters in the basin, including soil type and thickness, 

vegetation classifications, and glacier coverage are defined at the pixel scale.  Applying the 
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model using a variety of glacier sizes along with variable climate conditions has provided 

the first detailed, quantitative information on the timing and contribution of snow and 

glacier melt in the Middle Fork basin.    

 DHSVM simulations were performed at a 1-hour time-step for WYs 2003-2005, and 

with hypothetical meteorological input files.  GIS pixel resolution was set at 50 m x 50 m 

for all simulations.  SWE was well represented by DHSVM when compared to that 

measured at the Middle Fork SNOTEL site. Stream discharge and timing were also well 

represented when compared to that recorded at the USGS stream gauge.  Peak stream 

discharge was typically underestimated by DHSVM; however, the quality of discharge 

measurements above 4,000 cfs is considered poor by the USGS.  Summer streamflow was 

slightly underestimated and is likely due to poor constraints on the amount and distribution 

of snow in the basin. 

 The calibrated model was used to simulate streamflow under present climate 

conditions and hypothetical climate conditions including drought, increased precipitation, 

and predicted climate conditions.  It was also applied using a variety of glacier coverages 

including the estimated LIA maximum extent, 2002 coverage, 17% reduction in glacier size 

(predicted for year 2050), and 48% reduction in glacier size (predicted for year 2150).  

Applying DHSVM in this manner, I was able to establish a non-linear relationship between 

glacier size and meltwater contribution to streamflow based on present climate conditions 

(Figure 29).  Based on combinations of the above variable climate conditions and glacier 

coverages, the major conclusions of this study are as follows. 
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Glacial meltwater component of late-summer streamflow 

1. The glacial meltwater component of late-summer streamflow as defined by the 2002 

glacier coverage and present climate conditions ranged from 8.4% to 26.1%. 

2. The glacial meltwater component of late-summer streamflow as defined by the 2002 

glacier coverage and drought conditions ranged from 21.4% to 32.0%. 

3. The glacial meltwater component of late-summer streamflow as defined by the 2002 

glacier coverage and increased precipitation conditions was steady at 4.3%. 

4.  The glacial meltwater component of late-summer streamflow as defined by the 2002 

glacier coverage and predicted climate conditions ranged from 11.3% to 33.7%. 

Decrease in late-summer streamflow as a result of glacier shrinkage  

1. A 17% reduction in glacier size (predicted for year 2050) may result in a decrease in 

late-summer stream discharge of 3.1% to 8.6% with present climate conditions. 

2. A 48% reduction in glacier size (predicted for year 2150) may result in a decrease in 

late-summer stream discharge of 6.7% to 19.4% with present climate conditions.  

Increase/decrease in late-summer streamflow as a result of variable climate scenarios  

1. Drought conditions may result in a decrease in late-summer stream discharge of 

9.6% to 67.6%. 

2. Increased precipitation conditions may result in an increase in late-summer stream 

discharge of 7.8% to 195.2%. 

3. Predicted climate conditions may result in a decrease in late-summer stream 

discharge of 6.2% to 10.2% with the 2002 glacier coverage. 

4. Predicted climate conditions may result in a decrease in late-summer stream 

discharge of 8.7% to 15.7% with the predicted 2050 glacier coverage. 
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Timing and volume of glacial melt 

1. The glacial melt period typically lasts from mid-June through mid-October for 

glaciers defined at their 2002 extent and under present climate conditions. Glaciers 

begin melting slightly earlier, stop melting slightly later, and produce more discharge 

during a dry year than a wet year.  

2. The timing of glacial melt is similar for present conditions and the increased 

precipitation scenario.  Glaciers began melting earlier in the year and stopped 

melting later in the year for the drought and predicted climate scenarios.   

 

7.0 FUTURE WORK 

 Deming glacier meltwater is an essential component of the water resources for the 

City of Bellingham, WA.  Future monitoring of the glacial component of streamflow, not 

only in the Middle Fork but in the greater Nooksack River, is crucial to assess future water 

resource management in Whatcom County.  I provide the following recommendations to 

improve this application of DHSVM and to evaluate the effects of glaciers throughout the 

Nooksack watershed. 

 Incorporate the use of PRISM precipitation grids into this application of DHSVM. 

 Incorporate the use of multiple stations into this application of DHSVM. 

 Evaluate the effect of deglaciation on the Nooksack watershed.  The South Fork of the 

Nooksack is not glaciated, but the North Fork is. Create a DHSVM model of the North 

Fork and apply DHSVM to examine the effect and implications of deglaciation on the 

entire Nooksack watershed. 

 Examine more rigorously the influence of climate change and drought conditions.  
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TABLES 

 

Oct 0.28 12.2 Oct 0.06 5.95 Oct 0.06 7.35 Oct 0.06 5.30 Oct 0.59 5.30
Nov 0.17 4.4 Nov 0.35 4.92 Nov 0.37 6.32 Nov 0.35 1.93 Nov 0.57 1.93
Dec 0.07 4.5 Dec 0.34 0.27 Dec 0.36 1.67 Dec 0.33 0.75 Dec 0.34 0.75
Jan 0.15 -4 Jan 0.42 2.71 Jan 0.44 4.11 Jan 0.41 0.14 Jan 0.43 0.14
Feb 0.05 4.63 Feb 0.17 0.64 Feb 0.18 1.49 Feb 0.13 1.68 Feb 0.17 1.68
Mar 0.13 6.93 Mar 0.52 -0.37 Mar 0.55 1.03 Mar 0.26 1.82 Mar 0.52 1.82
Apr 0.09 9.5 Apr 0.21 1.47 Apr 0.20 3.27 Apr 0.04 3.61 Apr 0.23 3.61
May 0.07 12.5 May 0.10 4.77 May 0.10 6.57 May 0.10 7.41 May 0.15 7.41
Jun 0.04 16.5 Jun 0.08 9.94 Jun 0.07 11.74 Jun 0.07 6.76 Jun 0.12 6.76
Jul 0.06 17.9 Jul 0.02 13.12 Jul 0.01 14.92 Jul 0.02 11.30 Jul 0.10 11.30
Aug 0.01 17.3 Aug 0.01 12.59 Aug 0.01 14.39 Aug 0.01 13.17 Aug 0.19 13.17
Sep 0.04 15.6 Sep 0.12 11.00 Sep 0.12 12.77 Sep 0.12 7.33 Sep 0.27 7.33
SUM 1.16 NA SUM 2.40 NA SUM 2.47 NA SUM 1.90 NA SUM 3.68 NA
Oct 0.14 10.9 Oct 0.59 6.55 Oct 0.62 7.95
Nov 0.19 5.9 Nov 0.57 -1.09 Nov 0.60 0.31
Dec 0.19 4.9 Dec 0.33 -1.07 Dec 0.34 0.32
Jan 0.15 3.1 Jan 0.41 -0.91 Jan 0.43 0.49
Feb 0.06 6.1 Feb 0.13 0.53 Feb 0.13 1.93
Mar 0.13 8.6 Mar 0.34 1.50 Mar 0.36 2.90
Apr 0.03 11.8 Apr 0.04 5.27 Apr 0.04 7.07
May 0.08 13.7 May 0.15 5.54 May 0.14 7.34
Jun 0.03 16.8 Jun 0.08 10.84 Jun 0.08 12.64
Jul 0.02 19.1 Jul 0.02 3.47 Jul 0.02 15.27
Aug 0.10 19.1 Aug 0.19 13.67 Aug 0.19 15.47
Sep 0.13 14.5 Sep 0.27 7.55 Sep 0.26 9.35
SUM 1.23 NA SUM 3.12 NA SUM 3.21 NA
Oct 0.18 11.3 Oct 0.25 5.30 Oct 0.26 6.70
Nov 0.12 5.2 Nov 0.47 1.93 Nov 0.49 3.33
Dec 0.14 4.0 Dec 0.34 0.75 Dec 0.36 2.15
Jan 0.20 3.2 Jan 0.43 0.14 Jan 0.45 1.54
Feb 0.05 5.2 Feb 0.13 1.68 Feb 0.13 3.08
Mar 0.15 8.4 Mar 0.26 1.82 Mar 0.27 3.22
Apr 0.12 9.9 Apr 0.23 3.61 Apr 0.22 5.41
May 0.09 14.7 May 0.13 7.41 May 0.13 9.21
Jun 0.05 15.6 Jun 0.12 6.76 Jun 0.12 8.56
Jul 0.03 17.8 Jul 0.10 11.30 Jul 0.10 13.10
Aug 0.04 18.0 Aug 0.04 13.17 Aug 0.04 14.97
Sep 0.08 14.1 Sep 0.21 7.33 Sep 0.20 9.13
SUM 1.26 NA SUM 2.71 NA SUM 2.77 NA
Oct 0.11 10.3
Nov 0.16 5.9
Dec 0.15 3.1
Jan 0.13 2.9
Feb 0.11 4.9
Mar 0.1 7.2
Apr 0.09 9.9
May 0.08 13
Jun 0.07 15.3
Jul 0.05 17.4
Aug 0.04 17.4
Sep 0.07 14.8
SUM 1.16 NA
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 Table 1: Monthly precipitation sums and monthly average temperature for meteorological data used as model input. 
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 Vegetation Type 
 4 5 8 10 12 13 14 15 20 
 

Vegetation Parameter 
Deciduous 
Broadleaf 

Mixed 
Forest 

Closed 
Shrub Grassland Bare Urban Water Coastal 

Conifer Glacier 

Impervious fraction 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 
Max Snow Int Capacity 0.003 0.003 NA NA NA NA NA 0.04 NA 
Vapor pressure deficit 4.0E+03 4.0E+03 4.0E+03 4.0E+03 NA 4.0E+03 NA 4.0E+03 NA 
# of root zones 3 3 3 3 3 3 3 3 3 

Overstory LIA Variable       
2.0-10.0 

Variable 
2.0-6.0 

Variable 
1.0-4.0 

Variable     
0.5-6.0 0.0 Variable 

1.0-3.0 0.0 12.0 0.0 

Understory LIA Variable       
2.0-3.0 

Variable   
2.0-3.0 

Variable 
1.0-4.0 0.19 0.0 Variable 

1.0-3.0 0.0 3.0 0.0 

% of Middle Fork basin 1.4% 3.1% 19.0% 2.2% 5.8% 0.1% 0.1% 65.1% 3.1% 
 Table 2: Vegetation hydrologic parameters For Middle Fork basin.  For a complete list of vegetation hydrologic parameters 
 refer to the DHSVM webpage: www.hydro.washington.edu/Lettenmaier/Models/DHSVM/index.htm  

 
 

 Soil Type 
 1 3 5 6 8 14 15 
 

Soil Parameter 
Sand Sandy 

Loam Silt Loam Silty Clay 
Loam 

Water 
(as clay) Bedrock 

Lateral conductivity 0.01 0.01 0.01 0.02 0.01 0.01 0.01 
Vertical conductivity 0.01 0.01 0.01 0.01 0.01 0.01 0.01 
Maximum infiltration 2.00E-04 3.00E-05 3.00E-05 1.00E-05 3.00E-05 1.00E-05 1.00E-05 
Porosity 0.43 0.4 0.52 0.43 0.48 0.47 0.1 
Filed Capacity 0.08 0.21 0.28 0.29 0.36 0.36 0.05 
Bulk Density 1492 1569 1280 1485 1381 1394 1650 
% of Middle Fork basin 3.7% 8.4% 2.1% 14.5% 50.7% 13.0% 7.5% 

 
  Table 3: Soil hydrologic parameters for Middle Fork basin.  For a complete list of soil hydrologic parameters   

  refer to the DHSVM webpage: www.hydro.washington.edu/Lettenmaier/Models/DHSVM/index.htm 
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UTM Coordinates 

Station East North 
Altitude 

(m AMSL) 
Wells Creek SNOTEL 589486 5412391 1280 
Elbow Lake SNOTEL 580957 5393360 975 
Middle Fork SNOTEL 579280 5407790 1518 
North Shore weather station 548924 5399557 126 
USGS stream gauge 565385 5403163 177 

     
    Table 4: Location of weather and stream gauging stations used for this thesis.   
     Coordinates are UTM Zone 10, datum NAD 27. 
 
 

 
 Glacier coverage in MF basin 

Time Period 
% change  from 
2002 glacier size Km2 % of basin 

LIA           
(estimated) +144% 19.8 7.6 

2002           
(From NOAA) 0% 8.1 3.1 

2050           
(predicted) -17% 6.7 2.6 

2150           
(predicted) -48% 4.2 1.6 

 
Table 5: Glacier coverage in the Middle Fork basin for discrete time periods. 
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 Snow-water equivalent 
 
 

Simulated 
(m) 

Measured 
(m) 

Oct 0.01 0.01 
Nov 0.07 0.07 
Dec 0.19 0.21 
Jan 0.25 0.25 
Feb 0.29 0.25 
Mar 0.29 0.31 
Apr 0.46 0.67 
May 0.27 0.34 
Jun 0.17 0.00 
Jul 0.08 0.00 
Aug 0.04 0.00 
Sep 0.02 0.00 
SUM 2.12 2.12 

 
   Table 6: Measured and simulated monthly average snow-water equivalent defined at the  
    Middle Fork SNOTEL station. 
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Present Climate Conditions (WY 2003-2005 ) 

Glacier 
Coverage 

Meteorological 
Input file 

Total Simulated 
discharge (m3) 

% 
Annual 

(Oct-Sep) 

% 
Summer 

(Jun-Sep) 
% Late-summer 

(Aug-Sep) 
Start melt End melt 

WY 2003 4.57E+08 10.8 38.6 56.8 May 06 Nov 7 
WY 2004 5.87E+08 9.2 24.2 27.5 Apr 30 Oct 23 144% increase 

(LIA) 
WY 2005 5.08E+08 7.6 24.9 35.2 Apr 24 NA* 
WY 2003 4.18E+08 2.3 12.3 26.1 Jun 14 Oct 14 
WY 2004 5.45E+08 2.1 6.6 8.4 Jun 15 Oct 20 2002 
WY 2005 4.76E+08 1.5 5.8 11.1 Jun 15 NA* 
WY 2003 4.13E+08 1.3 7.8 19.2 Jun 28 Oct 13 
WY 2004 5.40E+08 1.3 4.0 5.5 Jun 23 Oct 20 

 
17% decrease 

(2050) WY 2005 4.73E+08 0.8 3.2 6.9 Jun 28 NA* 
WY 2003 4.09E+08 0.2 2.6 8.3 Jul 06 Oct 8 
WY 2004 5.36E+08 0.4 1.2 1.8 Jul 01 Oct 06 

48% decrease 
(2150) 

WY 2005 4.70E+08 0.2 0.8 2.0 Jul 23 NA* 
  
 Table 7: Contribution of glacial meltwater to streamflow in the Middle Fork Nooksack River produced by present     
  meteorological conditions (WY 2003-2005) and different glacier sizes. 
 
  *The glaciers were still melting at the end of the three-year model simulation. 
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Present Climate Conditions (WY 2003-2005 ) 

Glacier 
Coverage 

Meteorological 
Input file 

Simulated glacier 
discharge (accumulated; 

m3) 
% Change 
(Jun-Sep) 

WY 2003 4.92E+07 347.1 
WY 2004 5.40E+07 354.6 144% increase 

(LIA) 
WY 2005 3.87E+07 435.3 
WY 2003 9.67E+06 0.0 
WY 2004 1.15E+07 0.0 2002 
WY 2005 6.95E+06 0.0 
WY 2003 5.27E+06 -39.7 
WY 2004 6.86E+06 -40.2 

 
17% decrease 

(2050) WY 2005 3.75E+06 -45.9 
WY 2003 9.95E+05 -81.3 
WY 2004 2.00E+06 -82.7 48% decrease 

(2150) 
WY 2005 8.62E+05 -87.3 

 
         Table 8: Change in glacial meltwater discharge produced by present meteorological conditions and    
   different glacier coverages (all compared to 2002 glacier coverage). 
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Present Climate Conditions (WY 2003-2005 ) 

Glacier 
Coverage 

Meteorological 
Input file 

Total Simulated 
discharge (m3) 

% 
Annual 
(Oct-
Sep) 

% 
Summer 

(Jun-
Sep) 

% Late-
summer (Aug-

Sep) 
WY 2003 4.57E+08 9.46 42.7 70.95 
WY 2004 5.87E+08 7.75 23.3 26.39 

144% increase 
(LIA) 

WY 2005 5.08E+08 6.67 25.34 37.2 
WY 2003 4.18E+08 0.0 0.0 0.0 
WY 2004 5.45E+08 0.0 0.0 0.0 2002 
WY 2005 4.76E+08 0.0 0.0 0.0 
WY 2003 4.13E+08 -1.05 -4.88 -8.63 
WY 2004 5.40E+08 -0.85 -2.64 -3.05 

 
17% decrease 

(2050) 
WY 2005 4.73E+08 -0.67 -2.67 -4.46 
WY 2003 4.09E+08 -2.07 -10.01 -19.43 
WY 2004 5.36E+08 -1.74 -5.43 -6.7 

48% decrease 
(2150) 

WY 2005 4.70E+08 -1.28 -5.09 -9.31 
WY 2003 4.08E+08 -2.31 -12.3 -26.14 
WY 2004 5.33E+08 -2.16 -6.57 -8.4 

144% increase 
(LIA) 

WY 2005 4.69E+08 -1.46 -5.82 -11.1 
 

         Table 9: Change in total stream discharge produced by present meteorological conditions and different   
   glacier coverages (all compared to 2002glacier coverage). 
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Synthetic 5-year Drought 

Glacier 
Coverage Synthetic Year Total Simulated discharge 

(m3) 

% 
Annual 

(Oct-Sep) 

% 
Summer 

(Jun-Sep) 
% Late-summer 

(Aug-Sep) 
Start melt End melt 

1 yr 3.64E+08 2.91 14.2 21.4 May 09 Oct 30 
2 yr 3.51E+08 3.15 14.6 22.5 May 09 Oct 30 
3 yr 3.52E+08 3.15 14.6 31.5 May 13 Oct 31 
4 yr 3.51E+08 3.2 14.8 31.9 May 09 Oct 30 

2002 

5 yr 3.51E+08 3.2 14.8 32.0 May 09 NA 
Table 10: Contribution of glacial meltwater to streamflow in the Middle Fork Nooksack River based a hypothetical drought s

 cenario.  The drought file was used to simulate streamflow for 2002 glacier coverage. 
 
 

Synthetic 5-year Drought  
Glacier 

Coverage Synthetic Year Simulated glacier 
discharge (m3) 

% Change 
(Jun-Sep) 

1 yr 1.06E+07 9.6 
2 yr 1.10E+07 -4.3 2002 
3 yr 1.11E+07 59.7 

  Table 11: Change in glacial meltwater produced by drought conditions and 3.1% glacier coverage (compared to  
   meteorological conditions for WYs 2003-2005 and 2002 glacier coverage). 

 
 

Synthetic Drought for year 2050 (WY 2003-2005 ) 

Glacier 
Coverage Synthetic Year Simulated discharge for 

drought conditions (m3) 
Simulated discharge for 

WY 2003-2005 (m3) % Annual 
(Oct-Sep) 

% Summer (Jun-
Sep) 

% Late-
summer 

(Aug-Sep) 
1 yr 3.64E+08 4.18E+08 -12.8 -21.6 -9.6 
2 yr 3.51E+08 5.45E+08 -35.5 -55.8 -67.6 2002 
3 yr 3.52E+08 4.76E+08 -26 -35.7 -37.8 

 Table 12: Decrease in total stream discharge produced by drought conditions and 3.1% glacier coverage (compared to   
  meteorological conditions for WYs 2003-2005 and 2002 glacier coverage) 
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Increased Precipitation 

Glacier 
Coverage Synthetic Year Total Simulated discharge 

(m3) 

% 
Annual 

(Oct-Sep) 

% 
Summer 

(Jun-Sep) 
% Late-summer 

(Aug-Sep) 
Start melt End melt 

1 yr 6.52E+08 0.8 2.9 4.3 Jun 15 Oct 18 
2 yr 6.43E+08 0.8 2.9 4.3 Jun 15 Oct 18 
3 yr 6.43E+08 0.8 2.9 4.3 Jun 16 Oct 18 
4 yr 6.43E+08 0.8 2.9 4.3 Jun 16 Oct 18 

2002 

5 yr 6.43E+08 0.8 2.9 4.3 Jun 16 NA 
 Table 13: Contribution of glacial meltwater to streamflow in the Middle Fork Nooksack River based increased precipitation  
  scenario.  The increased precipitation file was used to simulate streamflow for 2002 glacier coverage. 
 

 
Increased Precipitation 

Glacier 
Coverage Synthetic Year Simulated glacier 

discharge (m3) 
% Change 
(Jun-Sep) 

1 yr 5.05E+06 -47.8 
2 yr 5.06E+06 -56.0 2002 
3 yr 5.05E+06 -27.3 

  Table 14: Change in glacial meltwater produced by increased precipitation conditions and 2002 glacier coverage  
   (compared to meteorological conditions for WYs 2003-2005 and 2002 glacier coverage). 
 
 

Increased Precipitation  

Glacier 
Coverage Synthetic Year 

Simulated discharge for 
increased precipitation 

(m3) 

Simulated discharge for 
WY 2003-2005 (m3) % Annual 

(Oct-Sep) 
% Summer (Jun-

Sep) 

% Late-
summer 

(Aug-Sep) 
1 yr 6.52E+08 4.18E+08 56.18 83.73 195.19 
2 yr 6.43E+08 5.45E+08 18.06 5.27 7.8 2002 
3 yr 6.42E+08 4.76E+08 35.01 49.59 106.65 

 Table 15: Increase in total stream discharge produced by increased precipitation conditions and 2002 glacier    
  coverage (compared to meteorological conditions for WYs 2003-2005 and 2002 glacier coverage). 
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Predicted Climate for year 2050 

Glacier 
Coverage 

Meteorological 
Input file 

Total Simulated discharge 
(m3) 

% 
Annual 

(Oct-Sep) 

% 
Summer 

(Jun-Sep) 
% Late-summer 

(Aug-Sep) 
Start melt End melt 

Adjusted  2003 4.37E+08 3.26 21.0 33.7 Jun 01 Nov 02 
Adjusted  2004 5.66E+08 2.74 10.0 11.3 May 25 Oct 20 2002 
Adjusted  2005 4.91E+08 2.23 10.5 16.1 May 12 NA 
Adjusted  2003 4.31E+08 2 14.6 26.2 June 09 Oct 31 
Adjusted  2004 5.60E+08 1.73 6.5 7.9 June 16 Oct 20 2050 
Adjusted  2005 4.87E+08 1.31 6.4 10.9 June 10 NA 

 Table 16: Contribution of glacial meltwater to streamflow in the Middle Fork Nooksack River based on a predicted future  
  climate scenario.  The file was used to simulate streamflow for 2002 and predicted 2050 glacier coverages. 

 
 
 
 

Predicted Climate for year 2050  
Glacier 

Coverage 
Meteorological 

Input file 
Simulated glacier 

discharge (m3) 
% Change 
(Jun-Sep) 

Adjusted  2003 1.43E+07 47.9 
Adjusted  2004 1.54E+07 33.9 2002 
Adjusted  2005 1.07E+07 60.4 
Adjusted  2003 8.64E+06 63.9 
Adjusted  2004 9.62E+06 52.8 2050 
Adjusted  2005 6.35E+06 69.3 

  Table 17: Change in glacial meltwater produced by predicted climate conditions and 2002 glacier coverage   
  (compared to meteorological conditions for WYs 2003-2005 and 2002 glacier coverage). 
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Predicted Climate for year 2050  

Glacier 
Coverage 

Meteorological 
Input file 

 Simulated discharge for 
predicted climate (m3) 

Simulated discharge for 
WY 2003-2005 (m3) % Annual 

(Oct-Sep) 
% Summer (Jun-

Sep) 

% Late-
summer 

(Aug-Sep) 
Adjusted  2003 4.37E+08 4.18E+08 4.62 -19.64 -6.23 
Adjusted  2004 5.66E+08 5.45E+08 3.77 -12.76 -5.14 2002 
Adjusted  2005 4.91E+08 4.76E+08 3.22 -12.81 -10.2 
Adjusted  2003 4.31E+08 4.13E+08 3.27 -25.7 -15.74 
Adjusted  2004 5.60E+08 5.40E+08 2.71 -15.98 -8.68 2050 
Adjusted  2005 4.87E+08 4.73E+08 2.25 -16.58 -15.44 

 Table 18: Change in stream discharge produced by the predicted climate scenario for 2002 and predicted 2050 glacier 
 coverage (compared to meteorological conditions for WYs 2003-2005 and 2002 and 2050 glacier coverage, respectively).
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Figure 1: Location of weather stations and stream gauge, main tributaries of the 
Nooksack River, the Middle Fork Nooksack River watershed, Lake Whatcom 
watershed, and the Middle Fork diversion, western Whatcom County, 
Washington. 
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Figure 2: Schematic diagram of DHSVM structure.  All modeling is based on established 
hydrologic relationships and each grid cell is able to exchange water with all adjacent cells 
(Modified from Wigmosta, 2001). 
 
 

 
Figure 3: Digital Elevation Model (DEM) for the Middle Fork Nooksack River basin.   
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Figure 4: Vegetation classifications for the Middle Fork Nooksack River basin.  Data were 
obtained from NOAA, 2002 (http://www.csc.noaa.gov /crs/lca/pacificcoast.html). 
 
 

 
Figure 5: Soil type in the Middle Fork Nooksack River basin created using STATSGO soil 
data (Miller and White, 1998).   
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Figure 6: Soil thickness in the Middle Fork Nooksack River basin created using an 
ARCInfo AML.  
 

 
Figure 7: Stream network in the Middle Fork Nooksack River basin created using ARCInfo 
AML . 
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Figure 8: 2.6% glacier coverage in the Middle Fork Nooksack River basin (17% reduction 
in glacier size compared to 2002 coverage; predicted for year 2050 AD).  

 
 
 

 
Figure 9: 1.6% glacier coverage in the Middle Fork Nooksack River basin (48% reduction 
in glacier size compared to 2002 coverage; predicted for year 2150 AD). 
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Figure 10: 7.6% glacier coverage in the Middle Fork Nooksack River Basin (144% 
increase in glacier size compared to 2002 coverage; estimated for the LIA maximum 
glacier extent). 
 
 

 
Figure 11: 0% glacier coverage in the Middle Fork Nooksack River basin.  
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Figure 12: Location and ages of wood samples used for radiocarbon dating in the Middle 

Fork Nooksack basin.  
 

 

2960 ±30, 2970 ±35 
 
2440 ±30, 2205±30 
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Figure 13: Daily mean discharge produced from the first DHSVM calibration simulation 
using default parameters. 
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Figure 14: Monthly mean streamflow produced by calibration simulations using two 
different soil thicknesses (soild5 = 1.0-2.5 m, soild6 = 1.0-3.5 m).   

 Error = -43.0% 
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Figure 15: Monthly mean streamflow produced by calibration simulations using two 
different precipitation lapse rates (0.001 m/m and 0.0001 m/m). 
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Figure 16: Monthly mean streamflow produced by calibration simulations using different 
temperature lapse rates (Simulation 34 = 0.0020 °C/km, Simulation 43 = variable, 
Simulation 55 = variable). 
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Figure 17: Daily mean discharge produced by calibration simulation before calibrating to 
snow-water equivalent. 
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Figure 18: Measured and simulated average monthly snow-water equivalent at the Middle 
Fork SNOTEL station from calibration simulations using different values for snow/rain 
threshold temperature. 

 Error = 0.54% 



 

 83

0

1000

2000

3000

4000

5000

6000

7000

10/1/2004 12/1/2004 2/1/2005 4/1/2005 6/1/2005 8/1/2005

Date

St
re

am
 D

is
ch

ar
ge

 (c
fs

)

Measured

Simulated

 
Figure 19: Daily mean discharge produced by calibration simulation for Water Year 2005.  
Snow/Rain threshold=4.0°C.  Temperature lapse rate = variable (Nov-Jun Lapse rate=-
0.006, Jul-Oct Lapse rate = -0.009), Precipitation Lapse rate =0.0001, KL soil type 8=0.005, 
soil depth range   = 1-2.5 m. 
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Figure 20: Daily mean discharge produced by validation simulation for water year 2003. 

 

 Error = -2.1% 

 Error = -2.9% 
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Figure 21: Daily mean discharge produced by validation simulation for Water Year 2004.   
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Figure 22: Total annual simulated and measured stream discharge for calibrated and 
validated application of DHSVM. 

 
 

 Error = 4.0% 
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Figure 23: Glacial meltwater contribution produced by water year 2003 meteorological 

input with 2002 glacier coverage. 
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Figure 24: Glacial meltwater contribution produced by water year 2003 meteorological 

input with 17% reduction in glacier size (predicted for year 2050).  
 



 86

0

100

200

300

400

500

600

700

800

900

05/ 31/ 2003-00:00:00 07/ 01/ 2003-00:00:00 08/ 01/ 2003-00:00:00 09/ 01/ 2003-00:00:00 10/ 02/ 2003-00:00:00

Date

St
re

am
 D

is
ch

ar
ge

 (c
fs

)

1.6% Glacier Coverage

Deglaciated

Glacial Melt

 
Figure 25: Glacial meltwater contribution produced by water year 2003 meteorological 

input with 48% reduction in glacier size (predicted for year 2150).  
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Figure 26: Glacial meltwater contribution produced by water year 2003 meteorological 

input with 144% increase in glacier size (estimated for LIA). 
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Figure 27: Summer stream hydrograph using present climate conditions and different  
            glacier coverages. 
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Figure 28: Measured monthly average snow-water equivalent at the Middle Fork SNOTEL 
 station for the three years used as meteorological data input. 
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Figure 29: Summary of the non-linear relationship between glacier size and runoff.  All 

simulations were based on present climate conditions and compared to 2002 glacier 
coverage.  
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Appendix A: DHSVM basin setup 
 

1. CREATE A DEM GRID 
1. Create a workspace.  I created a folder on the C drive called MFdhsvm and created a 
folder within MFdhsvm for dems. (C:/MFdhsvm/dems) 
 
2. Download and unzip Digital Elevation Models (DEMs).  
 I used the following DEMs in Washington State: Deming, Canyon Lake, Goat Mountain, 
Mt. Baker, Acme, Cavanaugh Creek, Twin Sisters, and Baker Pass. 
 
I downloaded them from:  
http://duff.geology.washington.edu/data/raster/tenmeter/ 

 
3. Convert DEM files to raster files 

Open ArcMap→Arc Toolbox→Conversion Tools→To Raster→DEM to Raster 
Input USGS DEM file: deming.dem 
Output raster: C:/MFdhsvm/dems/deming 
→OK 
This will convert the DEM to a raster, and import the raster to ArcMap.   
All DEMs have to be converted to raster files individually. 
 

4. Mosaic DEMS 
  a. Set analysis environment 
 From Spatial Analyst dropdown menu→Options  
 Under general tab, Working directory: C:/MFdhsvm/dems. 
 Under Extent tab, Analysis extent: Union of Inputs 
 Under Cell size tab, Analysis cell size: Maximum of Inputs 
 →OK 
  b. Mosaic the DEMs using Raster Calculator 
 Open Spatial Analyst toolbar → raster calculator   

Create the Mosaic expression in the text box: 
 <Nooksackdem>=mosaic ([deming], [CanyonLake], [etc.]) 
 →Evaluate 
  c. Once DEMs are mosaicked, locate the new DEM in ArcCatalog and drag it into 
ArcMap.   
 
5. Resample DEMs to 50 m by 50 m pixel resolution.   
  a. Set analysis environment (very important) 

Open ArcToolbox→Data Management tools→Raster→Resample→environment  
  Under General Settings tab:  

Present Workspace: (C:/MFdhsvm/dems) 
 Scratch Workspace (C:/MFdhsvm/dems) 
 Output coordinate system: Same as layer “Nooksackdem” 
 Output Extent: Same as layer “Nooksackdem” 
  Under Raster Analysis settings tab: 
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 Cell size: 50 
Mask: None 
→OK  

 
b. Resample: 

Input Raster: “Nooksackdem” 
Output Raster: “dem50” 
Cell size: 50 
Resampling Technique: Nearest 
→OK 

 
Once the mosaicked raster is resampled to 50m resolution, Nooksackdem (10 m resolution) 
can be removed from ArcMap. 
 
2. CREATE A WATERSHED MASK 
1. Create another folder within the MFdhsvm folder.  I titled mine “setup”. 
 
2. Fill sinks to even out the dem 
Open hydrology/models toolbar→Fill Sinks 
Input surface: dem50 
Fill limit:  <Fill_All> 
Output raster: C:/MFdhsvm/setup/filldem 
→OK 
 
3. Perform flow direction on the filled DEM.  This grid is necessary for determining the 
watershed boundary. 
Open hydrology/models toolbar→Flow direction 
Input surface: filldem 
Output raster: C:/MFdhsvm/setup/flowdir 
→OK 
 
4. Perform flow accumulation.  This grid is also necessary for determining the watershed 
boundary. 
Open hydrology/models toolbar→Flow accumulation 
Direction raster: flowdir 
Output raster: C:/MFdhsvm/setup/flowacc 
→OK 
 
5. Set interactive properties to create a watershed boundary 
Open hydrology/models toolbar→Interactive properties 
Flow direction: flowdir 
Flow accumulation: flowacc 
→OK 
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6. Create the watershed boundary 
Click the watershed button from the hydrology/models toolbar. 
 
This is an interactive tool which will determine the boundary of the watershed based on the 
destination cell.  I selected the point at which the Middle Fork converges with the main 
channel of the Nooksack River and ArcGIS determined which cells would eventually drain 
water to that point.  I had to repeat the process a number of times before I was satisfied with 
the watershed boundary.   
When a watershed is created, it may be a temporary file.  To make it permanent, right-click 
on the watershed grid in ArcMap table of contents→Make Permanent→set source to the 
present workspace (C:/MFdhsvm/setup/watershed). 
 
7. Create a watershed polygon 
I created a watershed polygon that is used to clip the grids that are necessary input for 
DHSVM. 
Open ArcToolbox→Conversion Tools→From Raster→Raster to Polygon 
Input raster: C:/MFdhsvm/setup/watershed 
Output polygon features: C:/MFdhsvm/setup/watershedpoly 
→OK 
 
8. Once the watershed polygon is created, it can be used to clip the DEM and hillshade 
(optional) to the watershed. 
Set working environment: 
Click Spatial Analysts toolbar→ Options 
Working directory: C:/MFdhsvm/setup 
Analysis mask: watershedpoly 
Extent: watershedpoly 
Cellsize: 50 
 
From Spatial Analyst dropdown menu→raster calculator 
Type the expression: sheddem=nooksackdem 
→Evaluate 
 
3. CREATE A LANDCOVER GRID 
1.  Download 2001 landcover grid from NOAA from 
http://www.csc.noaa.gov/crs/lca/pacificcoast.html. 
I downloaded the coverage for the entire west coast. 
 
The landcover file is already an ESRI grid, so it does not need to be converted.  The PCS 
may be different than that for the DEM, but ArcGIS should be able to project the grid on the 
fly.    
 
2. Resample grid to 50 by 50 m resolution. 
Open ArcToolbox→Data management Tools→Raster→Resample 
Set the analysis environment (very important): 

http://www.csc.noaa.gov/crs/lca/pacificcoast.html
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Under General Settings tab:  
 Present Workspace: (C:/MFdhsvm/setup) 
 Scratch Workspace (C:/MFdhsvm/setup) 
 Output coordinate system: Same as layer “Nooksackdem” 
 Output Extent: Same as layer “Nooksackdem” 
  Under Raster Analysis settings tab: 
 Cell size: 50 

Mask: None 
→OK to close environments setting 

 
Input raster: landcover 
Output raster: landcover50 
Output cell size: 50 
Resampling technique: nearest neighbor 
→OK 
 
3. Clip landcover grid to watershed boundary. 
Set analysis environment: 
Click Spatial Analysts toolbar→ Options 
Working directory: C:/MFdhsvm/setup 
Analysis mask: watershedpoly 
Extent: watershedpoly 
Cellsize: 50 
 
From Spatial Analyst dropdown menu→raster calculator 
Type the expression: shedcover=landcover50 
→Evaluate 
 
4. Reclassify NOAA vegetation classifications to DHSVM classifications 
Open ArcToolbox→Spatial Analyst→Reclass→Reclassify 
Set general and raster analysis environments 
Input Raster: landshed 
Output Raster: reclassveg 
Reclass Field: Value 
Then: 
 
NOAA NOAA DHSVM DHSVM 

2 High Intensity Developed 13 Urban 
3 Low Intensity Developed 13 Urban 
5 Grassland 10 Grassland 
6 Deciduous Forest 4 Deciduous Broadleaf 
7 Evergreen Forest 15 Coastal Conifer 
8 Mixed Forest 5 Mixed Forest 
9 Scrub/Shrub 8 Closed Shrub 
10 Palustrine Forested Wetland 4 Deciduous Broadleaf 
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11 Palustrine Scrub/Shrub Wetland 8 Closed Shrub 
12 Palustrine Emergent Wetland 10 Grassland 
16 Unconsolidated Shore 12 Bare 
17 Bare land 12 Bare 
18 Water 14 Water 
19 Palustrine Aquatic Bed 14 Water 
22 Ice 20 Ice 

 
4.  CREATE VARIABLE GLACIER GRIDS 
1. Map out glacial moraines.  I used a stereo pair of aerial photos to map moraines.   
 
2. Determine retreat rate of glacier(s) (see section 4.1.3). 
 
3. Download digital aerial photos and bring them into ArcMap. I downloaded photos 
from http://gis.ess.washington.edu/data/raster/doqs.html, and merged them using the 
‘mosaic’ command in Raster Calculator (see ‘mosaic DEMs’). 
 
4.  Create a new feature in ArcCatalog 
Open ArcCatalog →Open your workspace (I created a new workspace called ‘glacier 
coverages’ in the ‘setup’ folder →click new→shapefile→Name: glacier2050, Feature Type: 
polygon. 
 
Drag the new shapefile into ArcMap table of contents along with the aerial photos and 
present vegetation layer. 
 
5. Edit the new shapefile 
In ArcMap click Editor→start editing→select glacier2050→Task: create new feature, 
Target: glacier2050.  
 
Click on the pencil; begin digitizing the past or future glacier coverages by creating 
polygons that will be merged with the present vegetation grid.  I used the measuring tool, the 
present vegetation grid, and the air photos to aid in digitizing.When creating smaller 
glaciers, the polygons will be reclassified to ‘Bare’ soil type and then merged with the 
vegetation grid. 
 
6. Convert the shape file to a raster (see ‘convert soil polygon to raster’ below) 
 
7.  Reclassify the new raster to vegetation type 12 (bare) or type 20 (Ice) (See 
‘Reclassify NOAA vegetation classifications to DHSVM classifications’ above). 
 
 
8.  Merge the reclassified raster with the original landcover grid.   
In the Spatial Analyst drop down menu, set options. 
Open Raster Calculator→Type: Glacier2050 = merge ({reclassified raster},{veg grid}) 
→Evaluate 

http://gis.ess.washington.edu/data/raster/doqs.html
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Glacier2050 is now the new vegetation grid representing smaller glaciers. 
 
5. CREATE A SOIL TEXTURE GRID 
1. Download soil texture coverage from STATSGO for Whatcom County, WA from 
http://www.essc.psu.edu/soil_info/etc/statsgolist.cgi?statename=Washington 
I created a new folder within C:/MFdhsvm called soils.  Save the file (wa.e00) in this file. 
2. Convert file.  This is a GIS export file that has to be converted in ArcCatalog. 
Open ArcCatolog→Conversion Tools→Import from Interchange File 
Input file: C:\MFdhsvm\soil\wa.e00\wa.e00 
Output dataset: C:\MFdhsvm\soil\wa 
The file will now appear in ArcCatolog and can be dragged into ArcMap. 
The PCS may be different than that for the DEM, but ArcGIS should be able to project the 
grid on the fly.    
 
3. Convert soil polygon to raster. 
Open ArcToolbox→Conversion Tools→To Raster→Feature to Raster 
Set analysis environments by clicking on the Environments button 
Under General Settings tab:  

Present Workspace: (C:/MFdhsvm/soils) 
 Scratch Workspace (C:/MFdhsvm/soils) 
 Output coordinate system: Same as layer “Nooksackdem” 
 Output Extent: Same as layer “Nooksackdem” 
  Under Raster Analysis settings tab: 
 Cell size: 50 

Mask: None 
OK to close environments setting 
 
Input features: wa polygon 
Field: MUID 
Output raster: C:\MFdhsvm\soil\wa.e00\wa\soilgrid 
Output cell size: 50 
→OK 
 
Remove wa polygon from ArcMap 
 
4. Clip soil grid to watershed 
Set analysis environment: 
Click Spatial Analysts toolbar→ Options 
Working directory: C:/MFdhsvm/soils 
Analysis mask: watershedpoly 
Extent: watershedpoly 
Cellsize: 50 
 
From Spatial Analyst dropdown menu→raster calculator 

http://www.essc.psu.edu/soil_info/etc/statsgolist.cgi?statename=Washington
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Type the expression: soilshed=soilgrid 
→Evaluate 
 
Soil classifications are as follows:  
MUID Description MUID Description 
1* Sand 10 Sandy Clay 
2 Loamy Sand 11 Silty Clay 
3* Sandy Loam 12 Clay 
4 Silty Loam 13 Organic (as loam) 
5* Silt 14* Water (as clay) 
6* Loam 15* Bedrock 
7 Sandy Clay Loam 16 Other (as SCL) 
8* Silty Clay Loam 17 Muck 
9 Clay Loam 18 Talus 
* Soil classifications in the Middle Fork Nooksack basin 
 
6.  CREATE SOIL DEPTH AND STREAM NETWORK GRIDS 
I created the soil depth and stream network grids using Arc in the spatial analysis lab (AH 
16) using the following methods: 
 
1. Create a workspace 
Create a new folder: C:/TEMP/soild 
 
Copy the watershed grid (watershed), the clipped dem (sheddem) and amlscripts from the 
DHSVM tutorial into the “soild” folder. 
 
Check the computer to ensure that it has a Java Runtime Environment (JRE).  If it doesn’t, 
download Java software from www.sun.com. 
To check for JRE, open Arc and type: 
Arc: &sys java –version 
If the JRE is installed, you should get: 
Java version “1.4.2_04” 
Java [TM] 2 Runtime Environment, Standard Edition (build 1.4.2_04-b04) 
Java HotSpot[TM] Client VM (build 1.4.2_04-b04, mixed mode). 
 
The watershed mask values must be defined as inbasin=1 and outside basin=NODATA.  
Otherwise the AML will create a stream network for the entire raster.  You can check the 
values in ArcMap by opening the DEM properties dialogue. 
 
***Before running the AML, make sure to change the path to AddAat2.class from with the 
createstreamnetwork AML.  If this step is skipped, the AML will encounter an error, but 
will continue to run anyway.  It will produce zeros within the streamnetwork.dat for slope, 
segorder, etc. and DHSVM cannot use this file.*** 
 
 

http://www.sun.com/
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I simply opened the AML, used the ‘find’ tool to locate the path and changed the path to: 
&sys java -classpath ../soild/amlscripts/ AddAat2 %streamnet% 

 
2. Run the AML 
Open ARC.   
Type: 
ARC: &workspace C:/TEMP/soild 
ARC: &watch aml.watch 
ARC: &amlpath C:/TEMP/soild/amlscripts 
ARC: &run createstreamnetwork sheddem watershed mf_soild mf_streams MASK 220000 
0.76 1.5 
 
The last three numbers are variables representing the minimum contributing area before a 
channel begins, the minimum soil depth, and maximum soil depth (in meters). 
 
7. CREATE A SERIES OF SHADING MAPS 
1. Create a workspace 
Create a new folder: C:/TEMP/shadow 
 
Copy the clipped dem (sheddem) into this folder using ArcCatalog.    The solar AML 
(process_solar1 is not available in the amlscripts folder in the DHSVM tutorial, but can be 
found in the amlscripts folder on the attached cd).  This file should also be copied into the 
shadow folder. Process_solar.aml requires 3 “C” files to run.  I compiled these using the 
‘lcc’ compiler in the Computer Science department with the help of Matt Paskus.  The 
compiled files which are make_dhsvm_shade_maps.exe, skyview.exe, and 
average_shadow.exe, can also be found on the attached cd.  Copy these files into the 
‘shadow’ file. 
 
2. Run the AML 
Type: 
Arc: &workspace C:/TEMP/shadow 
Arc: &watch aml.watch 
Arc: &amlpath C:/TEMP/shadow/amlscripts 
Arc: &r process_solar1 middlefork sheddem 1 0.0 
Arc: quit 
 
The basin name is “middlefork” and the elevation grid is “sheddem”.  The last two numbers 
represent the model timestep and GMT offset, respectively. 
 
The AML command “rm” is not recognized in Windows.  I transferred the shadow maps to 
Horton anyway, and renamed each file (ex: ‘Shadow.01.hourly.bin’ is renamed 
‘shadow.01.bin’). 
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8.  EXPORT DEM, SOIL TYPE, SOIL THICKNESS, VEGETATION, AND 
WATERSHED FILES AS ASCII GRIDS 
 I created a new file for each conversion and copied the GIS grid to be converted into the 
file.   
I then convert all the NoData values in the grids to something that DHSVM recognizes (e.g., 
water=14) and converted the grids to ascii format. 
Example: 
For the watershed grid, Type: 
Arc: &workspace C:TEMP/watershed      (with “watershed” grid) 
Arc: grid 
GRID: watershed.asc = gridascii(con(isnull(watershed),14,watershed)) 
GRID: q 
 
9. CONVERT ASCII GRIDS TO BINARY 
I converted the ascii gids (soilclass.asc, vegclass.asc, and mask.asc) to binary files on 
Horton using “myconvert” in the input file.   
**The correct variable type for each grid is as follows:** 
Mask, landcover, soil type: unsigned character or “uchar” 
Dem, soildepth: float 
  
Example (for mask, landcover, soil type): 
horton > ./myconvert ascii uchar mask.asc mask.bin 375 496 
 
Example (for dem, soildepth): 
horton > ./myconvert ascii float DEM.asc DEM.bin 375 496 
 
Where: 
horton> ./myconvert source_format target_format source_file target_file number_of_rows 
number_of_columns 
 
 
10. CREATE A FINAL STREAM MAP AND STREAM NETWORK FILE 
I created these files on Horton using “assign”. The files stream.network.dat and 
stream.map.dat were created during step #5 (stream network grid). mf.stream-net.dat and 
mf.stream-map.dat are the final map and network files. 
 
Example: 
horton>./assign stream.network.dat stream.map.dat mf.stream-net.dat mf.stream-map.dat 
 
 
11.  LOCATE THE STREAM GAUGE FOR DHSVM CALIBRATION. 
The stream gage location in DHSVM is based on the location of the end of a stream segment 
generated in the stream network aml, not the actual location of the gage.  Open ArcMap.  
Drag into a new, empty map: sheddem and the streams arc.  Locate the position of the 
stream gauge using the coordinate indicators in the lower right corner of the screen, or plot 
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the location of the stream gauge using “Tools” and “add X Y data”.  The output segment is 
the segment that terminates the closest to the stream gauge location.  Stream discharge is not 
at a pixel, it is at the end of a selected stream segment.  After the stream gauge is located, 
click on the stream segment nearest the gauge to determine the stream segment ID #.  
Record the segment number/value. In the stream network file, type ‘SAVE’ next to the 
appropriate stream segment. 
 
12. SET INITIAL CONDITIONS FOR DHSVM CALIBRATION 
1. Create initial channel state files: 
Unix: % awk’ {print $1, 0.1} mf.stream_net.dat> channel.state.9.30.2003.00.00 
2. Create model state files 
I used initialstate.txt that is found in the dshvm tutorial and changed the path, date, and # of 
rows and columns. 
 
Then: 
Horton: MakeModelStateBin InitialState.txt 
This creates the initial Interception, Snow, and Soil state files for the date that is specified in 
the initialstate.txt file.  The date indicates the beginning of the model simulation. 
 
13. RUN THE MODEL 
From the mfork directory (horton/carrie/dhsvm/mfork>) 
horton> DHSVM input.mfork 
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     Appendix B:  All simulations performed for model calibration and validation. 
 

 Simulation 
Water 
Year initial State 

Met 
Stations % error Parameters 

0 2005 Dry 
Elbow, 

Wells, MF NA NA 

1 2002 
End of 

simulation 1 
Elbow, 

Wells, MF -39.18% Default parameter settings 

2 2002 
End of 

simulation 1 
Elbow, 

Wells, MF -34.95% 
Changed lateral hydraulic conductivity for dominant soil type (8) (from 0.01 
to 0.005) 

3 2002 
End of 

simulation 1 
Elbow, 

Wells, MF -41.80% Changed lateral hydraulic conductivity for all soil types (from 0.01 to 0.005) 

4 2002 
End of 

simulation 1 
Elbow, 

Wells, MF -41.90% Changed soil thickness range from 1-2.5 to 1-3.5m 

5 2002 
End of 

simulation 1 
Elbow, 

Wells, MF -40.34% Doubled precipitation lapse rate (from 0.0012 to 0.0024) 

7 2002 
End of 

simulation 1 
Elbow, 
Wells -40.34% Doubled precipitation lapse rate (from 0.0012 to 0.0024) 

8 2002 
End of 

simulation 1 
Elbow, 
Wells -35.70% 4x precipitation lapse rate (0.0048) 

3 
st

at
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11 2002 
End of 

simulation 1 
Elbow, 
Wells -32.52% 5x precipitation lapse rate (0.0060) 

Table B1: Simulations performed using all three meteorological data sets: Elbow Lake, Wells Creek, and Middle Fork 
SNOTEL stations. 

 

 Simulation 
Water 
Year initial State 

Met 
Stations % error Parameters 

9 2002 
End of 

simulation 1 Elbow Lake 42.19% Default parameter settings, Elbow Lake only 

6 2002 
End of 

simulation 1 Elbow Lake 49.24% 2x precipitation lapse rate (0.0024) 

10 2002 
End of 

simulation 1 Elbow Lake 41.91% Changed soil thickness range from 1-2.5 to 1-3.5m 1 
St

at
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n 

12 2002 
End of 

simulation 1 
Elbow Lake 

39.60% 1/2x precipitation lapse rate (0.0006) 
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13 2002 
End of 

simulation 1 Elbow Lake 37.74% 1/4x precipitation lapse rate (0.0003) 

14 2002 
End of 

simulation 1 Elbow Lake 41.99% default precipitation lapse rate, KL of soil type 8 0.005 

15 2002 
End of 

simulation 1 Elbow Lake 37.33% P-lapse rate 0.0003, Soild 6 (1-3.5m), KL of soil type 8 0.005 

16 2002 
End of 

simulation 1 Elbow Lake 37.57% P-lapse rate 0.0003, Soild 6 (1-3.5m), KL of soil type 8 0.002 

17 2002 
End of 

simulation 1 Elbow Lake 35.13% P-lapse rate 0, Soild 6 (1-3.5m), KL of soil type 8 0.002 

 

19 2005 
End of 

simulation 1 Elbow Lake 21.46% P-lapse rate 0, Soild 6 (1-3.5m), KL of soil type 8 0.002 
     Table B2: Simulations performed using only Elbow Lake SNOTEL station (Continued from above). 

 
 

 Simulation 
Water 
Year initial State 

Met 
Stations % error Parameters 

22 2005 
End of 

simulation 1 Middle Fork -43.03% Default parameter settings, Middle Fork only 

23 2005 
End of 

simulation 1 Middle Fork -43.28% KL of soil type 8 0.005 

24 2005 
End of 

simulation 1 Middle Fork -55.32% KL of soil type 8 0.005, 2X precipitation lapse rate (0.0024) 

25 2005 
End of 

simulation 1 Middle Fork -40.99% KL of soil type 8 0.005, 1/2X temperature lapse rate (0.00325) 

26 2005 
End of 

simulation 1 Middle Fork -40.50% KL of soil type 8 0.02, 1/2X temperature lapse rate (0.00325) 

27 2005 
End of 

simulation 1 Middle Fork -42.64% KL of soil type 8 0.04, default temperature lapse rate 

28 2005 
End of 

simulation 1 Middle Fork -48.41% 2X temperature lapse rate (0.013) 

M
id

dl
e 

Fo
rk

 S
N

O
T

E
L

 o
nl

y 

29 2005 
End of 

simulation 1 Middle Fork 
-43.42% 

default settings, soild6 
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30 2005 
End of 

simulation 1 Middle Fork 3.67% all default except precipitation lapse rate = 0.000 

31 2005 
End of 

simulation 1 Middle Fork 0.67% P-lapse rate =0.0001, T-lapse rate=0.0040, KL soil8=0.05, soild5 

32 2005 
End of 

simulation 1 Middle Fork 0.13% P-lapse rate =0.0001, T-lapse rate=0.0065, KL soil8=0.05, soild5 

33 2005 
End of 

simulation 1 Middle Fork 0.69% P-lapse rate =0.0001, T-lapse rate=0.0040, KL soil8=0.005, soild5 

34 2005 
End of 

simulation 1 Middle Fork 0.48% P-lapse rate =0.0001, T-lapse rate=0.0020, KL soil8=0.005, soild5 

35 2005 
End of 

simulation 1 Middle Fork 0.54% 
P-lapse rate =0.0001, T-lapse rate=0.0020, KL soil8=0.005, soild5, snow 
threshold =0.25 

36 2005 
End of 

simulation 1 Middle Fork 1.65% 
P-lapse rate =0.00005, T-lapse rate=0.0020, KL soil8=0.005, soild5, snow 
threshold =0.25 

37 2005 
End of 

simulation 1 Middle Fork 0.61% 
P-lapse rate =0.0001, T-lapse rate=0.0020, KL soil8=0.005, soild5, snow 
threshold =0.00 

38 
2005 

End of 
simulation 1 Middle Fork 3.88% 

P-lapse rate =0.0001, T-lapse rate=0.0100, KL soil8=0.005, soild5, snow 
threshold =0.00 

39 2005 
End of 

simulation 1 Middle Fork 41.43% 
P-lapse rate =0.0010, T-lapse rate=0.0100, KL soil8=0.005, soild5, snow 
threshold =0.00 

40 2005 
End of 

simulation 1 Middle Fork 39.00% Same as above except veg 20 = glacier, not Ice 

41 2005 
End of 

simulation 1 Middle Fork 4.39% 
P-lapse rate =0.0001, T-lapse rate=0.0020, KL soil8=0.005, soild5, snow 
threshold =0.00 

42 2005 
End of 

simulation 1 Middle Fork NA incomplete model run 

43 2005 
End of 

simulation 1 Middle Fork 1.29% P-lapse rate =0.0001, T-lapse rate=variable2, KL soil8=0.005, soild5 

44 2005 
End of 

simulation 1 Middle Fork 3.34% P-lapse rate =0.0001, T-lapse rate=variable3, KL soil8=0.005, soild5 

45 2005 
End of 

simulation 1 
Middle Fork 

3.16% P-lapse rate =0.0001, T-lapse rate=variable4, KL soil8=0.005, soild5 

101



 102

46 2005 
End of 

simulation 1 Middle Fork 2.81% P-lapse rate =0.0001, T-lapse rate=variable5, KL soil8=0.005, soild5 

47 2005 
End of 

simulation 1 Middle Fork 3.31% P-lapse rate =0.0001, T-lapse rate=variable6, KL soil8=0.005, soild5, 

48 2005 
End of 

simulation 1 Middle Fork 0.55% 
P-lapse rate =0.0001, T-lapse rate=variable5, KL soil8=0.005, soild5, snow 
threshold =5.0, 

49 2005 
End of 

simulation 1 Middle Fork 1.27% 
P-lapse rate =0.0001, T-lapse rate=variable3, KL soil8=0.005, soild5, snow 
threshold =5.0, 

50 2005 
End of 

simulation 1 Middle Fork 0.41% 
P-lapse rate =0.0001, T-lapse rate=variable2, KL soil8=0.005, soild5, snow 
threshold =5.0, 

51 2005 
End of 

simulation 1 Middle Fork 0.66% 
P-lapse rate =0.0001, T-lapse rate=variable7, KL soil8=0.005, soild5, snow 
threshold =5.0, 

52 2005 
End of 

simulation 1 Middle Fork 44.99% 
P-lapse rate =0.0012, T-lapse rate=variable7, KL soil8=0.005, soild5, snow 
threshold =5.0, 

53 2005 
End of 

simulation 1 Middle Fork 1.01% 
P-lapse rate =0.0001, T-lapse rate=variable7, KL soil8=0.005, soild5, snow 
threshold =5.0, Ice 

54 
2005 

End of 
simulation 1 Middle Fork 1.13% 

P-lapse rate =0.0001, T-lapse rate=variable8, KL soil8=0.005, soild5, snow 
threshold =5.0, glacier 

55 2005 
End of 

simulation 1 Middle Fork 1.9% 
P-lapse rate =0.0001, T-lapse rate=variable8, KL soil8=0.005, soild5, snow 
threshold =4.0, Ice 

56 2004-05 
End of 

simulation 1 Middle Fork 1.82% 
P-lapse rate =0.0001, T-lapse rate=variable8, KL soil8=0.005, soild5, snow 
threshold =4.0, Ice 

Table B3: Simulations performed using only Middle Fork SNOTEL station.  Simulations 55 and 56 are the final calibration 
and validation simulations (Continued from above). 
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Appendix C: Contents of Disc 
 
Sample input file 
 input.mfork 
 
Middle Fork basin GIS: 
 Digital Elevation Model  
 Vegetation 
 Soil Classifications 
 Soil thickness 
 Stream network 
 Watershed boundary 
 Glaciers 
 
Meteorological Input Files 
 Middle Fork SNOTEL 
 Wells Creek 
 Elbow Lake 
 
Other 
 Middle Fork streamflow records 
 AML Files 
 Compiled C code for shadow maps 
 Thesis in pdf format  
 
 
 
 
 


